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Preface

This document describes the enhancements and changes incorporated into 
Trillium Software® System Version 15.0.0, cumulative through TSS v15.7.4, 
along with information about TSS installations, documentation, and 
troubleshooting.

Intended Audience
This document is intended for new and existing TSS customers who want to 
learn more about the latest versions of the software. 

Cross-References to More Information
Throughout the release notes there are cross-references to TSS online help 
topics and technical manuals that describe in more detail many of the 
enhancements. 

Cross references point to manuals or specific topics in the TSS and ECS Help, 
using the format Top Level Book > Topic > Sub-Topic. For example, for more 
information about N-way joins and Join Projects in the TSS Help, see Discover 
> Data Analysis Projects > About Join Projects. 
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Trillium Software Resources
For a comprehensive resource library of Trillium Software white papers, case 
studies, solution overviews, webcasts, education webinars, and related 
information, visit the Trillium Software website: trilliumsoftware.com

Regional Offices

Customer Support
Trillium Software Customer Support is available Monday through Friday, 24 
hours a day, to help you with any questions you may have about the Trillium 
Software System. This service is available to all customers who have active 
Trillium Software maintenance plans.             

US trlinfo@trilliumsoftware.com

+1 (978) 436-8900

UK/EMEA trillium.uk@trilliumsoftware.com

+44 (0) 118 940 7676

Central Europe trillium_de@trilliumsoftware.com

+49 (0) 7031 714756

Email  TrilliumSupport@syncsort.com

Tel  978-901-0000 (Worldwide Headquarters)
 +44 (0) 118 940 7676 (European 

Headquarters)

Scan code to access the 
Trillium Software website:
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Education Services
Trillium Software offers a variety of training services to get you started and 
incorporates advanced techniques to guide you through every implementation 
of the Trillium Software System:

 Classroom-based training 
 Mobile training at customer sites
 Recorded webinars

For more information about selecting courses, requesting in-person training 
sessions, or to view webinars, visit the Trillium Software Education website at: 
www.trilliumsoftware.com/services/education. 

Email Trillium Software Education directly at: 
trileducation@trilliumsoftware.com

Trillium Consulting
Trillium Software offers comprehensive and expedient technical consulting 
services that include:

 Advisory Services: Accelerate implementation, adoption, and ensure 
rapid time-to-value, with our best-practice guidance and sustainable 
data quality and data governance processes.

 Implementation Services: Drive ongoing data quality improvement 
with a proven approach that blends our methodology, technology, and 
expertise.

 Customized Solutions: Improve customer and reference data, and 
design and implement sustainable data governance processes.

To inquire about consulting services, call +1 (978) 436-8900.
TSS v15 Release Notes 11
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TSS Installation Information
CHAPTER 1

TSS Installation Information

This chapter describes the installation considerations for TSS depending on 
whether you are installing TSS for the first time or if you have an earlier 
version installed. 

The chapter includes the following sections:
 TSS Important Changes on page 12
 Supported Windows Platforms on page 14
 Browser Support on page 15
 Install Information
 About Installing TSS on page 16
 Installation Package on page 18
 Installing Standalone TS Web Server on page 21

TSS Important Changes
Note the following changes: 

 Trillium™ Quality for Big Data. For TSS v15.7, the solution Trillium 
Quality™ for Big Data is now available to deploy Trillium Quality 
projects to your Hadoop environment. Trillium Quality for Big Data 
integrates Trillium’s data quality application with Syncsort DMX-h to 
cleanse and match your data in the Hadoop framework. For more 
information, see Trillium™ Quality for Big Data on page 115.

As of v15.7, TS Quality for Hadoop is discontinued and is no 
longer installed with EDQ software.

 Trillium Discovery and Collibra Integration. New for v15.7, this 
solution is installed with the TSS Windows and Linux repository server 
software and includes a Collibra-Trillium.zip file that contains the 
integration project files. The solution is installed in the following default 
location:
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TSS Installation Information
•   Windows: C:\Program Files (x86)\Trillium Software\MBSW\15\
          svr\Collibra

•   Linux: install_path/server/metabase/svr/collibra
For more information, see the Trillium Discovery and Collibra 
Integration Administration and User’s Guide installed with the solution. 

 HP-UX Itanium. As of TSS v15.4, HP-UX Itanium systems are no 
longer supported. TSS v15.3 was the last release to support HP-UX.

Support for HP-UX PA-RISC was previously discontinued.

 Apache Tomcat
•   As of v15.7.4, the version of Apache Tomcat installed with the TSS 

server has been upgraded to v8.5.32. 
•   After you install the TSS repository server, you must start Apache 

Tomcat server. For details, see the TSS Installation Guide. 
•   Set Apache Tomcat Ports (New Installations Only). The TSS server 

installation sets the Apache Tomcat start port to 8080 and the stop 
port to 8005. After you install the TSS server, if you install 
Enterprise Connectivity Solutions (ECS) and you plan to use 32-bit 
TS Web Services, verify (and change if needed) the Apache Tomcat 
start and stop ports in the server.xml file on your server system. 
server.xml is located in the following location:

Windows: C:\Program Files (x86)\Trillium Software\MBSW\
   15\Apache_Tomcat\conf 

UNIX: server_install_path/metabase/Apache_Tomcat/conf
•   If you have an existing instance of TSS v15 installed, and you have 

made changes to the 32-bit Apache Tomcat server.xml file, to 
retain these changes:

a. Before you upgrade, rename the existing server.xml file as a 
backup file (for example, server.xml.bak) for reference.

b. Install TSS. The server will install a new server.xml file. 

c. After TSS is installed, update the new server.xml file with your 
modifications as needed. 

For more information and the full procedure, see the TSS 
Installation Guide.
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TSS Installation Information
 Java
•   Java is no longer installed with the TSS server software. 
•   TSS requires Java 1.8. Before you install TSS v15.7, you must install 

Java/JRE (or JDK) 1.8, 32- or 64-bit version depending on the 
components you install:

If you use the TS Director Software Development Kit (SDK) 
samples for Java, Java 1.6, 1.7, and 1.8 are supported. 
Ensure you select the correct version of the TrilTGenClient.jar 
executable in the Trillium Software\ECS\15\samples\SDK\
Java directory.

•   Install Java to the default install location on your server system. On 
Windows, the location is: C:\Program Files (x86)\Java. Restart 
your system after installation.

•   Set the JRE_HOME environment variable to point to the default Java 
installation.

 Solaris Sun. If you have a TSS v15.3 (or earlier) server installed on a 
32-bit Solaris Sun system and you are running 32-bit TS Web Services 
(part of TS Director/Enterprise Connectivity Solutions) you cannot 
upgrade to TSS v15.7 because Java 1.8 is unavailable for 32-bit Solaris 
Sun platforms. 

Supported Windows Platforms
 Microsoft Windows 10
 Microsoft Windows 8
 Microsoft Windows 7
 Microsoft Windows Server 2016
 Microsoft Windows Server 2012
 Microsoft Windows Server 2012 R2
 Microsoft Windows Server 2008

As of v15 update 2, Windows Vista and Windows Server 2003 are no 
longer supported. 

Repository Server and Enterprise Connectivity Solutions/TS Director

 Windows
 Linux
 AIX

JRE 1.8 32-bit

 Solaris Sun JRE 1.8 64-bit

Enterprise Data Quality (EDQ)

 Windows
 Linux

JRE 1.8 64-bit
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TSS Installation Information
Browser Support
This section describes the browser support for the Control Center, the Trillium 
Administration Center and the Discovery Center client software.

Control Center (TSS Client)
Internet Explorer 10 and 11. If your client system is on Windows 10, you must 
use IE 11; Microsoft Edge is not supported. See the TSS Installation Guide for 
additional prerequisites and system requirements. 

Administration Center and Discovery Center
Internet Explorer versions 10 and 11, Google Chrome, and Microsoft Edge.

Install Information
Note the following important information and install changes:

 Java/JRE 1.8. You must install Java/JRE 1.8 before running the TSS 
server installation. As of TSS v15.4, Java/JRE is no longer installed with 
TSS. 

 Enterprise Data Quality (EDQ). In TSS v15.2, EDQ was introduced. 
EDQ is an installation package that includes TSQ 64-bit processing 
support for Windows and Linux systems. It installs 64-bit enabled TSQ 
core modules, TS Quality for Real Time, and TS Quality for SAP. (As of 
v15.7, TS Quality for Hadoop is no longer installed with EDQ.) For more 
information about EDQ and 64-bit, see EDQ 64-Bit Enabled TSQ Data 
Processing on page 84. For additional information and requirements, 
see the Installing EDQ chapter of the TSS Installation Guide. 

EDQ installation for Windows requires Microsoft Visual C++ 2013 
Redistributable Package on the server system. Download from: https://
www.microsoft.com/en-us/download/details.aspx?id=40784

 SAP. SAP for 32-bit operating systems is no longer installed with ECS. 
SAP for 64-bit is available when you install TSS EDQ. For more 
information, see TS Quality for SAP (SAP Connector) on page 92. 

 SAP/Director. For the Trillium™ Quality for SAP, and for any client 
using TS Director, after installation you must set the following 
environment variables:
•   TRILLDIRADDR: Name of the host or IP address (in dotted decimal 

format) of the node on which the Director listens. Set on client and 
cleansing/matching service machines.

•   TRILLDIRPORT: Port on which the Director listens for incoming 
requests. Set on client and cleansing/matching service machines.
TSS v15 Release Notes 15



TSS Installation Information
About Installing TSS
This section includes important information about installing TSS. 

New Installations
If you are installing Trillium Software System for the first time, see the TSS 
Installation Guide for guidelines and procedures. The PDF is installed with the 
product and is available as follows:

 On the Trillium Software FTP download site, in the Documentation 
folder. 

 On the Trillium Software Customer Portal (see Accessing Documentation 
on page 124).

Existing Instances
Upgrades from earlier versions of v15 are supported with the release of v15.7. 

Upgrades apply to the following TSS software:
 Repository server
 TS Quality core
 Client/Control Center
 TS Director/ECS
 Batch Deployment Tool
 Country Templates
 OLE DB Provider 64-bit (OLE DB Reporting Adapter)
 ODBC Provider 64-bit (ODBC Reporting Adapter)
 Enterprise Data Quality (EDQ) 64-bit

If you have a TSS v15.3 (or earlier) server installed on a 32-bit 
Solaris Sun system and you are running 32-bit TS Web Services 
(part of TS Director/Enterprise Connectivity Solutions) you cannot 
upgrade to TSS v15.7 because Java 1.8 is unavailable for 32-bit 
Solaris Sun platforms. 

General Guidelines
Note the following guidelines and information:

 The TSS v15 installation package has changed from pre-v15 versions as 
follows:
•   The country templates are now installed separately and are no 

longer a part of the TS Quality installation process. This allows more 
timely availability of country template updates. This is a change 
from previous versions where the 32-bit core and country templates 
were installed together. 
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TSS Installation Information
•   The TS Quality 32-bit core modules are installed with the TSS 
repository server. This is a change from previous versions where the 
32-bit core and server were separate installs. (If you need to install 
only the TS Quality 32-bit core components, a separate install 
package is available for Windows and, for UNIX, separate core-only 
install command.) 

•   The 64-bit enabled core modules (introduced in TSS v15.2) are 
installed with EDQ. 

For more information about changes to install paths and 
directory structures in TSS v15, see the technical bulletin Install 
and Directory Structure Changes in TSS v15.0.0 available 
from the TSS software FTP site and the documentation page of 
the Trillium Software Customer Portal website.

 Most default port numbers for all TSS components are prepended with 
the product version number. For example, the default repository server 
port is 15040, the default repository server scheduler port is 15041, 
and so on. This simplifies installation of multiple versions of TSS 
components on the same server.

 After you install TSS, to use existing projects, import them into the 
latest Control Center. (Does not apply if you upgraded the client from a 
previous version of v15.)

 When you install TSS v15 and you have an existing instance of TSS 
from a pre-v15 release in your environment, you have the following 
options for handling existing data/repositories:
•   Create a new repository.
•   Convert a pre-v14 repository (that is, TSS Version 11.0.1, 11.5.2, 

12.0.1, 13.0, or 13.5.1).
•   Upgrade a v14 repository (that is, TSS version 14.x).
•   Use an existing repository that is not associated with any previous 

TSS installation.

If you plan to re-use a repository server from a pre-v15 version, it must 
satisfy the following conditions:

•   It must come from TSS Version 11.0.1, 11.5.2, 12.0.1, 13.0, 13.5.1 
or 14.x. 

•   It must be complete and valid.
•   It must be accessible from the server on which you are installing TSS 

v15.
 You do not need to disable User Account Control (UAC) to run the TSS 

installer, although you may encounter other situations where it must be 
disabled or lowered. See About User Permissions in the TSS Installation 
Guide for more information. 
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TSS Installation Information
Installation Package
The TSS installation packages are available as downloads from the Trillium 
Software FTP download site. 

The software is no longer available on CD/DVD. 

Table 1-1 describes the naming conventions and configurations for many of 
the TSS v15 installation packages available to you, depending on the license 
you purchased. 

The software posted on the FTP site is subject to change. 

Table 1-1  TSS Installation Package Delivery

FTP Directory Contents

Documentation 
(installed with the Control 
Center software unless 
otherwise noted)

PDFs of manuals and bulletins to help you install the software, including:
 TSS Install Guide
 Standalone Web Server Install Guide (procedure also included in the TSS 

Install Guide)*
 ECS/TS Director Install Guide
 TSS Release Notes
 TSS Technical Requirements*

*Available online only.
Additional documents and online help are installed with the software. 

TSS AIX Server  ECS software for Windows and AIX
 Batch Deployment Tool
 Country Templates
 TSS Server
 TSS Standalone Web Server. Install on a Windows system to allow the web 

server to communicate with the repository server.

TSS Case Management tss_case_mngmt_version.build_win.exe

TSS for SAP MDG SAR file that contains MDG software package. 
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TSS Installation Information
TSS Linux Server ECS
ECS executables for Windows and Linux:
 tss_ecs_15.n.n_build#_linux.bin
 tss_ecs_15.n.n_build#_win.exe

EDQ
EDQ executable: 
 tss_edq_15.n.n.build#_linux.bin

Top level files:
 Batch Deployment Tool executable: 
tss_bdt_15.n.n.build#_linux.sh   

 Country Templates executable: 
tss_ct_15.n.n.build#_linux.bin 

 Repository Server executable (includes 32-bit Quality core): 
tss_server_15.n.n.build#_linux.sh
(To install Quality 32-bit core only, use the ./setup -coreonly 
command.)

TSS SAP Add-Ons Zip file that includes the following add-ons:
 CRM600
 CRM700
 CRM701
 CRM702
 CRM703
 SAP700

TSS SunOS Server  ECS software for Windows and SUN
 Batch Deployment Tool
 Country Templates
 TSS Server
 TSS Standalone Web Server. Install on a Windows system to allow the web 

server to communicate with the repository server.

TSS Windows Control 
Center

TSS_Windows_Control_Center_Client_15.n.n.zip file that contains the 
following: 
 Batch Deployment Tool executable: 
tss_bdt_15.n.n.build#_win.exe   

 Control Center client executable: 
tss_client_15.n.n.build#_win.exe

 ODBC Reporting Adapter (32-bit version of the TS Reporting Adapter for 
ODBC) software: 
Odb32_15.n.n.build#.zip

 OLEDB64 Reporting Adapter software: 
tss_Odb64_15.n.n.build#.zip

The 32-bit version of the OLE DB TS Reporting Adapter is installed 
automatically when you install the Control Center.

Table 1-1  TSS Installation Package Delivery (Continued)
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TSS Control Center 
Client and Server

ECS
ECS executables for Windows:
 tss_ecs_15.n.n_build#_win.exe

EDQ
EDQ executable: 
 tss_edq_15.n.n.build#_windows.exe

TSS_Rep_Server_Control_Center_Windows_15.n.n.zip file that contains the 
following: 
 Batch Deployment Tool executable: 
tss_bdt_15.n.n.build#_win.exe   

 Control Center client executable: 
tss_client_15.n.n.build#_win.exe

 Country Templates executable: 
tss_ct_15.n.n.build#_win.exe 

 ODBC Reporting Adapter (32-bit version of the TS Reporting Adapter for 
ODBC) software: 
Odb32_15.n.n.build#.zip

 OLEDB64 Reporting Adapter software: 
tss_Odb64_15.n.n.build#.zip

 Repository Server executable (includes Quality core): 
tss_server_15.n.n.build#_win.exe
(A core-only software package for Windows is also available.)

The 32-bit version of the OLE DB TS Reporting Adapter is installed 
automatically when you install the Control Center.

TSS Windows ODBC64 
Reporting Adapter

setup.exe and associated files for 64-bit version of the
TS Reporting Adapter for ODBC.

TSS Windows Quality 
Core Only

tss_quality_core_15.n.n.build#_win.zip file that contains the core 
executable file tss_quality_core_15.n.n.build#_win.

TSS SAP Field 
Extensions CRM

Zip file that contains the software package. 

TSS SAP Field 
Extensions ERP

Zip file that contains the software package. 

TSS Windows Vendor 
ODBC Adapter

Zip file that contains the TSS vendor-supplied ODBC Setup.msi (for configuring 
this TSS repository loader connection)

Trillium Quality for Big 
Data

Two Apache Ambari service packages, one for the Big Data solution which 
includes DMX-h and Trillium Quality, and one for the TSS Postal Directories:
 Trillium Quality for Big Data: tsqbd-version-linuxOS.ambari-
                       service.bin

 Postal Directories: tss_directories-client_name.date-linuxOS.
               ambari-service.bin

where:
 version = the Trillium Quality for Big Data version number. For example, 

15.7.0.17306.bd.
 linuxOS = Linux OS version. For example, el7 for RHEL7.x.
 client_name.date = Client name and the date (YYMM) when the directories 

were built.

Table 1-1  TSS Installation Package Delivery (Continued)
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Installing Standalone TS Web Server 
The TS Web Server allows communication between the TSS repository server 
system and web-based TSS applications like the Administration Center and 
Discovery Center (formerly, Business Rules Center).

In Linux and Windows environments, when you install the TSS repository 
server, it automatically installs the TS Web Server. When you install the TSS 
server on AIX and Sun SPARC systems, the TS Web Server is not installed, 
therefore you must install the TS Web Server as a standalone application on a 
Windows system to allow the web server to communicate with the repository 
server.

Do not install the standalone web server on any Windows system 
that also has the TSS repository server installed. 

The standalone web server is available with the TSS installation software as a 
Windows install. Run the installer and follow the directions in the InstallShield 
Wizard. For the full procedure and guidelines, see Appendix B of the TSS 
Installation Guide. 
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CHAPTER 2

TSS v15.0 User Interface Enhancements

This chapter describes the enhancements and updates incorporated into the 
Control Center and Repository Manager interface, including:

 General Enhancements on page 22
 Expression Builder on page 23
 Views on page 25
 Notifications on page 26
 Environment Options on page 26
 Ribbon on page 27
 Quick Access Toolbar on page 27
 E-R Diagrams on page 28

General Enhancements
 Close warning. When working on a process in the Control Center, if 

you click the X button to close the window a message displays 
confirming that you want to close the window without saving any 
changes. 

 Locale Setting. The Control Center can display numeric values 
conforming to locale settings in the repository server. For example, if 
you set the locale option as German in the repository server, you will 
see the numeric value of one thousand displayed as 1.000,00. For more 
information in the TSS Help, see: Welcome to Trillium Software System 
> Locale View.

The repository administrator configures the locale setting when 
adding a repository. See TSS Repository Manager on page 62.
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Expression Builder
This section describes new and modified functions available throughout the 
Control Center from the Expression Builder. For more information about using 
functions in the TSS Help, see: Discover > Data Compliance Using Business 
Rules > Expression Builder > Expression Elements > Expression Builder 
Functions.

 When Using with Quality Conditionals. You can now select input 
and/or output attributes whenever you specify conditions or attribute 
transformations using the Expression Builder within a Transformer's 
Output Conditionals. The input attribute names will be preceded by the 
entity name associated with the input. For more information in the TSS 
Help, see: Develop > TS Quality Processes > Expression Builder > 
Expression Elements > Expression Builder Attributes.

 TCASE. The TCASE function converts a string to title case (initial cap). 
TCASE now has an optional argument named ANY. When used, the first 
character of each word plus the first alpha character after any non-
alpha character within the word will be returned in uppercase.

 Modifying Offsets. Offsets are used for the following three string 
functions in the Expression Builder:
 INSSTR—Insert one string into another string at the specified 

offset.
 OCCSTR—Parses a string to find the location of a substring and 

returns a numeric value equivalent to the position of the substring 
occurrence counted from the left of the string.

 SUBSTR—Returns a substring which describes characters at the 
beginning, middle, or end of a string.

By default, the offsets for these functions in the Expression Builder are 
1-based (offset by 1), unless you are working with a project created in 
a legacy (pre-Version 13) Quality project, in which case the results are 
0-based. You can change the offset base value by editing the TSS 
configuration file, config.txt, located in the server install directory on 
your TSS server system. On Windows this directory is C:/Program 
Files(x86)/Trillium Software/MBSW/15/etc.

For example, when you are importing a project created in pre-Version 
13.0, or you know that your project is 0-based, you can change the 
offset base value from 1 to 0 by editing the configuration file.

New Functions
The functions described in this section are new functions now available in the 
Expression Builder.

 DEDUPE. There is a new Quality function called DEDUPE, for use in the 
Transformer process and in the Set Selection utility. DEDUPE separates 
the value in an attribute into tokens and returns the deduped and 
delimited list of tokens. 
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 Mathematic. Eleven new mathematical functions have been added to 
the Expression Builder to support the implementation of fixed-point 
decimal arithmetic for numeric operations. TSS now supports 41 
significant digits and 20 digits after the decimal place for improved 
precision.
•   DIVIDEINT. Returns the integer part of the result of a division 

operation. Non-numeric values will return no results.
•   MAX. Returns the larger of two numbers. 
•   MIN. Returns the smaller of two numbers.
•   ROUND_05UP. Rounds up a decimal number to its nearest integer 

only if the number to be rounded is either 0 or 5. 
•   ROUND_CEILING. Rounds up a decimal number to the nearest 

integer with a bias towards infinity. 
•   ROUND_DOWN. Rounds down a decimal number to its nearest 

integer with a bias towards 0. 
•   ROUND_FLOOR. Rounds down a decimal number to its nearest 

integer with a bias towards negative infinity.
•   ROUND_HALF_DOWN. Rounds down a decimal number to the 

nearest integer. If equidistant (0.5), rounds down. 
•   ROUND_HALF_EVEN. Rounds a decimal number to the nearest 

integer. If equidistant (0.5), rounds so the result is an even number. 
•   ROUND_HALF_UP. Rounds up a decimal number to the nearest 

integer. If equidistant (0.5), rounds up. 
•   ROUND_UP. Rounds up a decimal number to its nearest integer 

with a bias away from 0. 
 Statistical. The following eight new statistical functions have been 

added to the Expression Builder in support of the percentiles and 
standard deviations statistical analysis:
•   ISOUTLIER. Returns true (1) for all numeric data whose deviation is 

equal to or greater than the deviation level specified with the 
function. The function returns false (0) for all numeric values with 
deviation less than the deviation level specified with the function. 

•   MEAN. Returns the numeric average of the values in an attribute, 
determined by the sum of values in the attribute divided by the 
number of values. 

•   MEDIAN. Median is the numeric value separating the higher half of 
a data set from the lower half. This function returns the median 
value of the specified attribute.

•   PERCENTRANK. Returns the rank of a specified numeric value in a 
data set. The percent rank represents the location of the percentile 
in a value. For example, halfway in a value the percentrank would be 
50%.

•   QUARTILE. A quartile is used to rank numeric data into quarters. 
The function returns the requested quartile of a value in an attribute 
as a percentage of the attribute. 
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•   STDDEV. Returns the standard deviation of an attribute. Standard 
deviation is used to measure how widely values are removed from 
the average value in an attribute. Use the results of this function to 
run the ISOUTLIER function.

 TOTAL. Returns the total of a specified attribute.
 VARIANCE. Returns the variance of a specified attribute. Use this 

function to determine how far values in an attribute are spread out. 

Statistics functions are not supported for Quality processes. Use 
functions on real entities in a test environment. 

Views

Background Tasks View
 Delete Multiple Background Tasks. You can now delete multiple 

background tasks at a time from a Background Tasks List View.
 Schedule Library Entity Import as Background Task. When you 

import entities into the Business Rule Library, you now have the option 
of scheduling the job. When scheduled, the import job will display as a 
background task. This allows you to better track the status of the 
import job and is useful in situations where you are importing hundreds 
of entities into the Library. 

 Rename Task. In the Background Tasks List View, a short-cut menu 
option is available to modify a job name: right-click a job, select 
Rename Task, make the necessary changes, then save the changes. 

List Views
 Edit User-Defined Columns. When you add columns in a List View 

using the Choose List View Columns window, you can now edit these 
user-defined columns. For more information, see the TSS Help: Tour of 
the Control Center > List Views > Organizing Information in List Views 
> Creating a Column in a List View. 

 Exporting List Views. Information displayed in a List View can be 
saved by exporting the data to an external file either on your local drive 
or on the repository server.  The procedure for exporting to the server 
has changed: Now you can only export to the /export directory on the 
server system. For more information in the TSS Help, see: Tour of the 
Control Center > List Views > Exporting Data in List Views.

Navigation Views
 Sort Entities and Attributes. You can sort the order of the entities 

that display in the Entities tab in ascending and descending order. You 
can also sort the attributes contained in an entity. By default, entities 
and attributes display in order based on the object identity numbers.
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Icon Views
 Setting Icon View Options. The Control Center now allows you to 

change the size of icons (either large or small) displayed in Icon Views 
of projects, library entities, and library attributes. For more information, 
in the TSS Help see: Getting Started > Customizing the User Interface 
> Setting Icon Options.

 Quality Process Icons. The TS Quality processes are now visually 
represented in a Quality Process Flow in one of two ways, either as 
arrows or as unique icons. For more information, see General 
Enhancements on page 36.

Summary Data View
 The Summary Data View has been enhanced to include graphs and 

charts that display profiling statistics analysis, including percentile and 
standard deviation metadata. 

Notifications
The following information now displays in the Control Center in a notification 
bar under the command tabs and Ribbon:

 Message, error, and warnings. Information messages display when a 
task or process successfully finishes. Errors and warnings display when 
a TSS problem is detected. 

 Task progress. When you insert a TS Quality process, add a process 
branch, or add an input to a Quality project, a progress notification bar 
displays information about the task in progress.

 Scheduled tasks. When you perform a scheduled task (for example, 
running a Quality process/project and creating an entity), the scheduler 
notification bar displays. You can either schedule the job to run now or 
later. You can also change the default name of the job when running 
one job at a time.

For more information about working with notifications and setting notification 
options, in the TSS Help see: Tour of the Control Center > Notifications.

Environment Options
 Server Connection Timeout Interval. Due to some TSS server 

systems running many processes concurrently, the response time to a 
client request (for example, connecting to a repository when you sign 
into the Control Center) can be slow to the point of timing out before 
the request is accepted.

There is a new Environment Options setting called Server Connection 
Timeout Interval. This option allows you to customize the number of 
seconds before the Control Center’s connection to the TSS server times 
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out.  Getting Started > Customizing the User Interface > Setting 
Environment Options. 

Ribbon
The Ribbon in the Control Center and the Repository Manager has been 
updated as follows:

 The Data Command set has been removed from the Ribbon. 
 The Refresh icon has been moved to the View command set. 
 In the Control Center, the Create Entity icon has been moved to the 

Create command set and is now labeled Entity. 

Figure 2-1  Control Center Ribbon

 When you open a List View, a new command set called Navigation 
displays on the Home tab, with Back and Display next list icons.  

This allows you to navigate through List Views without having to click 
the List View tab.

 The Control Center Analysis command set on the Home tab has two 
new icons:
 Click the Rules icon to access business rule management options:

       - Search business rules
       - Assign and manage business rules categories 
       - Assign and manage business rules priorities
       - Open and view saved library business rule searches

 Click the Name and Address icon to open the  Name and Address 
Analyzer.

Quick Access Toolbar
When you open a List View or Icon View, the menu items on those tabs are 
added to the Quick Access Toolbar drop-down list, and are available until you 
close the List or Icon View. This allows you to access these options regardless 
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of which Command set tab is active.

Figure 2-2  Quick Access Toolbar with List View Menu

E-R Diagrams
Printing Diagrams. You can now print an Entity Relationship (E-R) Diagram.
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CHAPTER 3

TSS v15.0 Data Discovery and Profiling 
Enhancements

This chapter describes the enhancements and changes incorporated into the 
Control Center profiling and discovery functionality, including: 

 Profiling Unstructured Business Data on page 29
 Attributes on page 30
 Entities on page 32
 Business Rules Management on page 33
 Join Projects on page 34

Profiling Unstructured Business Data
After you analyze words and phrases in the input attribute, you can create 
your own business data categories, along with the word and phrase definitions, 
that tell the Business Data Parser (BDP) process how to identify and 
standardize your business data. Word definition tables created in profiling are 
stored in the Library and can be imported for use in the BDP process.
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There are multiple ways to access to a word definition table during profiling 
activities.

 Attribute List View of phrases. Right-click the phrase and select Add to 
word definitions table.

 Attribute List View of values. Right-click the value and select Add to 
word definitions table.

 Value's Details View. Right-click the value and select Select Show wide 
value, and then select Open Word Table.

For more information in the TSS Help, see: Discover > Data Analysis > Data 
Content > Word Definition Tables.

Attributes
 View and Search Large Attributes. When working with large 

attribute values (those wider than the current resolution can display), 
you can now open the contents of individual cells in a List View and view 
them in a separate window. The window allows you to search for 
specific text in the value, change text size to better visualize the 
contents, and copy text into another application. You can also add 
words and phrases in a large attribute to an ignore words table. 

For more information in the TSS Help, see: Tour of the Control Center > 
List Views > Organizing Information in List Views > Displaying Wide 
Values in a List View. 

 Statistics Analysis. When you run an analysis of an attribute that 
contains numeric data (decimals and integers), there is now the option 
to analyze statistics including percentiles and standard deviations.
 Percentiles. A percentile is a rank which indicates the position of an 

attribute value in terms of percentage in a particular attribute in 
sorted order. For example, if the attribute values are sorted, a value 
at percent rank 20% is the value below which 20 percent of the 
attribute values are found.

 Standard Deviation. A standard deviation is a measure of how 
widely numeric values are dispersed from an attribute's mean 
(numeric average). The dispersion range is measured in levels. 
Deviation levels start at 0, 1, 2 and so on, continuing to the 
maximum found in the corresponding data. For example, if you have 
input data of 1 2 3 4 3 2 1 2 3 5 6 1, a standard deviation of 1.534 
will be the result. Data that falls toward the maximum range of 
deviations are called outliers. 

For more information in the TSS Help, see: Discover > Data Analysis > 
Data Content.

 Phrase Analysis
•   Analyze Metaphones. The Attribute Properties window now 

includes the option to analyze metaphones against phrases found 
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during phrase analysis for an attribute. You can drill down to similar 
phrases and to data that contains the selected phrase. 

•   Ignore Word Tables. When you run a phrase analysis for one or 
more attributes, words may be included which make it difficult to 
fully understand the results. For example, words that make it hard 
to identify identical phrases in your data. 

You can now create or import ignore word tables in the Library that 
you customize to include words you want the phrase analysis to 
ignore when generating the results. These tables are a way for you 
to instruct the analysis to ignore small or insignificant words or 
phrases that obscure the results. Customized ignore word tables can 
be imported for use into the Business Data Parser. 

For more information in the TSS Help, see: Discover > Data Analysis 
> Data Content > Ignore Words.

 Attribute Properties. The Attribute Properties window has been 
modified. It now includes two tabs, General and Analysis. 

From the General tab (Figure 3-1) you edit an attribute’s name, 
business description, Include in Joins check box, and Create Index 
check box. 

Figure 3-1  Attribute Properties - General Tab

From the Analysis tab, you configure and run analysis on derived 
metadata rules such as masks, metaphones, patterns, soundexes, 
percentile, and standard deviation. You also configure and run phrase 
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analysis, classify phrases on the basis of metaphones, and configure 
ignore words. 

Figure 3-2  Attribute Properties - Analysis Tab

To open the Attribute Properties window and analyze attributes, do one 
of the following:

•   To analyze a single attribute, right-click an attribute anywhere in the 
Control Center and select Attribute Properties.

•   To analyze multiple attributes, right-click an entity and select Drill 
down to derived metadata rules. In the Derived Metadata Rules 
List View, highlight all attributes whose properties you want to 
modify, right-click and select Selected Attributes Properties.

Entities
You can copy entities created during profiling activities and paste them in your 
Quality projects. For more information in the TSS Help, see: Develop > TS 
Quality Projects > Copying an Entity from Profiling. 
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Business Rules Management
This section describes enhancements made around the organization and 
management of business rules in the Control Center.

 Business Rules Analysis—No Rule Limit. You can now select more 
than 30 rules at a time when analyzing rules using the Re-analyze 
selected rules option. 

 Manage Rules from the Ribbon. The Control Center Analysis 
command set on the Home tab now has a Rules icon that is used to 
access business rule management options:
 Search business rules.
 Assign and manage business rules categories.
 Assign and manage business rules priorities.
 Open and view saved library business rule searches.

Business Rule Library
 Enable/Disable Standard ABRs. The Repository Manager has a new 

option that allows TSS administrators to control whether attribute 
business rules in the Standard library attribute are automatically copied 
to attributes when entities are created. 

 Rule Groups. There is a new library folder called Rule Groups which 
allows you to group rules for better management and organization. Rule 
groups allow you to:
 Analyze multiple grouped rules at a time, in top-level folders (affects 

all contained sub-folders) or in sub-folders. 
 Drill-down to rule results in an Icon View. 

For more information in the TSS Help, see: Discover > Data Compliance 
Using Business Rules > Business Rules Library > About Rule Groups. 

 Saved Search. Create a library business rule search and save it in a 
new library folder called Saved Search. You create searches using 
functions and operators available in the Expression Builder, allowing a 
more targeted filter on which to search results. Saved searches allow 
you to:
 Execute the saved search against a view of all entity and attribute 

business rules. 
 Re-analyze a rule or drill-down to see where the rule is used and the 

rule results. 
 Copy a search to create a new search, then modify as needed. 

For more information in the TSS Help, see: Discover > Data Compliance 
Using Business Rules > Business Rules Library > About Saved 
Searches.
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Join Projects
 Copying Join Projects. You can now copy a Join Project for situations 

where you want to reuse a project configuration. When you copy the 
project, you have the option of adding new input entities.

 Exporting/Importing Join Projects. Join Projects can now be 
exported to and imported from local systems and server systems. This 
allows you to move a Join Project to a different machine or repository.

 Editing Join Output Entity. When you create or modify a Join Project, 
you can now select columns to be included in a join entity. Use this 
feature when you want to hide attributes not needed for join analysis. 

Find more information about using N-way joins and Join Projects in the 
TSS Help: Discover > Data Analysis Projects > About Join Projects.
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CHAPTER 4

TSS v15.0 Data Quality Enhancements

This chapter describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes and projects. 
The enhancements are grouped into the following categories:

 General Enhancements on page 36
 Quality Projects on page 39
 Quality Processes on page 40

Important: Read First
When configuring the Global Data Router process, countries associated with 
Basic Countries (zz) template will not be available for processing through the 
zz country flow under the following conditions:

If you select the Display all countries check box and also choose to use all 
available countries for processing, countries associated with basic countries 
processing will not be available for selection in the Basic Countries edit 
window. 

You must click back to the Create Quality Projects - Countries window and 
remove Basic Countries (zz) from the Selected Countries list to proceed.
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General Enhancements
This section describes general data quality changes and enhancements in TSS 
v15.

 Data Browser. The Data Browser is a stand-alone tool that allows you 
to quickly view data in a file. It is not tied to any entities, schemas, or 
projects and is accessed from outside the Control Center. Use the Data 
Browser to examine any data file (for example, TSQ output files that are 
produced by running a project in batch) to verify its contents and 
format. For more information in the TSS Help, see: Develop > Data 
Browser.

 Regenerate TSQ Data. When you regenerate input TSQ data on a 
dynamic entity created using a ODBC connection, each attribute in the 
dynamic entity will be updated with new schema information from the 
source database.

 Viewing Large Parser Customization Log File. When you try to view 
the Parser Customization log file which is larger than 2 MB, you will get 
a message that says the file is too large to view. You then have the 
option of downloading the file for viewing on the client. For more 
information in TSS Help: Develop > TS Quality Processes > Viewing 
Process Results > Viewing Process Report Files.

 Additions to Basic Country List. The following countries have been 
added to the list of basic countries that display in the Control Center:
•   Kosovo (KV KOS)
•   Hong Kong - Traditional Chinese (CP950), native language 

version.
•   Macao - Traditional Chinese (CP950), native language version.
•   Thailand - Thai (CP874), native language version.

To use the native versions of Hong Kong, Macao, and 
Thailand, the input data must be in multi-byte native 
language. If the input data is in Latin-1 or English, use the 
Latin-1 versions such as Hong Kong (Latin-1) and Macao 
(Latin-1). For more information in the TSS Help, see the topic 
Basic Countries (ZZ Template).

 Changes to Basic Country List. Figure 4-1 describes updates to the 
list of basic countries in the Control Center. These are changes to only 
the names that are displayed within the Control Center; the support for 
these countries has not changed.

Table 4-1  Updates to Basic Country List

Country Listing Updated To

Heard Heard and McDonald Islands

Pitcairn Pitcairn Islands

Republic of Macedonia Macedonia
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 Quality Process Icons. The TS Quality processes are now visually 
represented in a Quality Process Flow one of two ways, either as arrows 
or as unique icons. Figure 4-1 shows each unique icon and its 
corresponding process. Icons can be enabled or disabled in the 
Environment Settings option window in the Control Center. For more 
information, in the TSS Help see: Getting Started > Customizing the 
User Interface > Setting Icon Options.

Saint Vincent Saint Vincent and the Grenadines

South Georgia South Georgia and South Sandwich 
Islands

Svalbard Svalbard and Jan Mayen Islands

Virgin Islands British Virgin Islands

Table 4-1  Updates to Basic Country List (Continued)
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Figure 4-1  Quality Process Icons
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 Entity Groups. Entity groups have been enhanced as follows:
•   Naming Entity Groups. When you create an entity group, you can 

now give the group a name. This helps label and organize the groups 
within a single project. If you do not name the group, TSS gives the 
group a default name. You can modify an entity group name at any 
time. 

•   Country Flow Entity Groups—Default Names. When you create a 
project and include entity groups for country flows in multi-country 
projects, the name of the group now includes the associated country 
code; for example, US Process Flow.

Quality Projects
This section describes the changes and enhancements made to TS Quality 
projects.

 Country Templates:
•   Business Projects. Creating a business project no longer requires a 

county template and customers are not required to purchase any 
country templates if they plan to implement customized business 
projects only. A generic template (WW template) is used out of the 
box.

•   build.txt File. Starting with TSS v15, a new file called build.txt 
will be installed in the country templates directory. It contains 
information about which version of the templates are installed.

•    all_country_recode table. A new table called all_country_
recode.tbl is now delivered with the country templates for 
reference purposes. The table contains a list of all supported 
countries and their respective 2- and 3-character ISO codes. For 
example, for Armenia the country codes are AM and ARM. 

This table is located in C:/Program Files (x86)/Trillium 
Software/MBSW/15/tsq/tables/general_resources. 

 Dynamic Entities. If you select a dynamic entity that has over 500 
rows and has not been regenerated, by default, the first 500 data rows 
in the source are used to generate the associated flat file. This flat file 
can be regenerated with a lesser or greater number of rows by 
regenerating the input data.

 Profiling Entities. You can copy entities created during profiling 
activities and paste them in your Quality projects. For more information 
in the TSS Help, see: Develop > TS Quality Projects > Copying an Entity 
from Profiling. 

 WW_PROJECT. The ww_project, along with the ww city table, are now 
installed automatically for all customers. This template is necessary to 
create user-defined projects.
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Quality Processes
This section describes the changes and enhancements made to processes, 
applications, utilities, and postal directories used in TS Quality projects and 
workflows, including the following (in alphabetical order):

 Analysis Process on page 40
 Commonizer on page 40
 Database Read/Write on page 41
 Data Parsers on page 41
 Directory Browser on page 45
 Geocoder on page 46
 Global Data Router on page 46
 Name and Address Analyzer on page 48
 Parser Tuner on page 48
 Postal Directory Browser on page 48
 Postal Directories on page 48
 Postal Matchers on page 49
 Relationship Linker on page 53
 Schema Editor on page 54
 Set Selection Utility on page 54
 Transformer on page 55
 Window Keys on page 57

Analysis Process
 Export to Batch. When you export a project containing an Analysis 

process into a batch script, the Analysis process will run as part of the 
batch execution. For more information in the TSS Help, see: Develop > 
TS Quality Processes > Profiling Processes > Using the Analysis 
Process. 

Commonizer
 Common Attributes. The Commonizer’s Common Attributes designate 

the decision routines (rules) used to copy data from one attribute into 
other attributes in the records linked by a match key. Now there is no 
limit to the number of rules you can add when editing Common 
Attributes in the Commonizer process. 

 Survivor Rules—New Option. When you designate a survivor record 
in the Commonizer, there is a new option called Always Create 
Survivor. This option determines how the Commonizer handles the 
survivor when none of the records match the decision routine. For more 
information in the TSS Help, see: Develop > Survivorship and 
Commonization > Designating the Survivor Record.
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 No Copy Option. When you specify the decision routines for 
commonizing or survivor selection, you can optionally select the non-
blank (NB), non-zero (NZ), and non-blank/non-zero (NBZ) options for 
certain routines. 

The no copy option is used in conjunction with the non-blank and/or 
non-zero options to prevent the Commonizer from selecting the first 
row when all rows contain either a blank or zero-filled values in the test 
attribute. For more information in the TSS Help, see: Develop > 
Survivorship and Commonization > Designating the Survivor Record.

Database Read/Write
 Commit Frequency Option. There is a new option for the Database 

Write process called Commit Frequency. The numeric value you enter 
for Commit Frequency controls the frequency of the records committed 
to the database. This allows you to track progress of the Database Write 
process and is useful when you want to locate process hangs. For more 
information in the TSS Help, see: Develop > Database Read/Write > 
How to Write Back Data to a Database. 

 Maximum Attribute Size. The maximum attribute size is now 32KB 
for the Database Read/Write process when exported in batch. Attributes 
that are bigger than 32KB, such as Text fields in a SQL Database, are 
truncated.

 Final Output Delimiter Option Unsupported. The Database Write 
process does not write to an output file, it writes directly back to the 
database. Therefore, when the last process in a Quality project is 
Database Write, and upon exporting the project to a batch script you 
select a delimiter character for the Final Output Delimiter, when you run 
the batch script it will fail at the last step, which is creating the output 
delimited file. 

To avoid this, do not select any delimiter character for the Final Output 
Delimiter option. 

This only applies to projects that have Database Write as the last 
process in the project flow.

Data Parsers
This section describes changes and enhancements to the Business and 
Customer Data Parsers, along with general parser enhancements.

 Parsing Exceptions File. If you do not need the parsing exceptions 
file, select the check box named Exceptions file not required. This 
option is available when you specify output settings for the CDP and 
BDP. 

This option is useful because the parsing exceptions file can become 
very large and have an impact on processing. By default, this option is 
not selected and the parsing exceptions file will be generated. 
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Business Data Parser
 New Option. By default, the BDP converts all plus signs (+) to 

ampersands (&). There is a new option called Turn off conversion of 
plus signs to ampersands. Check this option if you do not want the 
BDP to convert all plus signs to ampersands. 

This option is available on Options tab when you edit the BDP process.

 Category ID. When you use the BDP Word Definitions Tool to define 
the business data categories, each category is now automatically 
assigned a unique ID number which is displayed in the Control Center 
for reference. 

 Import Customized Table. You can now import customized word 
definitions tables and ignore word tables from either the Library or from 
the client system.

 Rename Output Attributes. In v15, the BP_USER1-500 attributes are 
now renamed using the corresponding category name when you import 
a word definition table into the BDP, as follows: 

The Single type category names will replace BP_USER1 - 25 and the 
Multi type category names will replace BP_USER26 -500. All related 
BP_USERx, BP_USERx_DISPLAY and BP_DATA_PRESENT_USERx 
attribute names will be replaced with the format of category_RECODE, 
category, and category_DATA_PRESENT, respectively. For example, if 
you have a category called "YEAR," the output attribute names will be 
YEAR_RECODE, YEAR, and YEAR_DATA_PRESENT.

 Remove Output Attributes. When you import a word definition table 
from the Library or client you have the option to remove unneeded 
output attributes. 

For more information about the BDP in the TSS Help, see: Develop > 
About Business Data Parser.
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Customer Data Parser
 Options:

•   The advanced option called Use a spelling algorithm when 
matching city names is now called Spelling algorithm for 
matching city names. There is now a choice of three algorithms to 
be used for matching the input city name against the city table. 
Corresponds to the CDP APPLY_CITY_SPELLING_ALGORITHM 
setting. 

•   Use City Changes File. When Spelling algorithm for matching 
city names is set to Enhanced spelling algorithm, the new 
option Use city changes file becomes available. 

In the Advanced Rules section of the CDP you then have the option 
to copy a city changes file to your system, customize it by adding 
entries to the REPLACE_CHARACTER and SWAP_WORDS 
parameters, and upload it again for use in the process. 

These entries instruct the process to use the specified characters 
and words to look up city names. By using this secondary table, the 
process can obtain better matching in table lookup. (The city 
changes file is also available in the Global Data Router.)

For more information in the TSS Help, see: Develop > Customer 
Data Parser > Setting Up the Customer Data Parser > Editing 
Advanced Rules Files.

•   Additional Geography Lookup. There is a new option called 
Additional Geography Lookup which validates province/city/postcode 
combinations against the auxiliary city table and updates or appends 
information in the output. This option will return the flag (Y/N) in the 
pr_verified_geography attribute. For Hong Kong, this option also 
returns ISLAND for some cities in the pr_sub_city attribute. (This 
option is associated with the new xxAUXCIT.ben/len file, described 
below.)              

This option is not available for the following countries: Basic 
Countries (ZZ), China (CN), United Kingdom (GB), Japan (JP), 
Korea (KR), Singapore (SG), and Taiwan (TW). 
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For Canada (CA), Netherlands (NL), and Portugal (PT), the 
flag in the pr_verified_geography attribute is not available.

•   Lookup All City Combinations. There is a new option called 
Lookup All City Combinations which looks up all word combinations 
for city when the city lookup process is performed for a multi-word 
input. By default, the lookup is not performed for all combinations 
when the initial full string is not a city.

•   Output All Name Data. Select this option if you want to write out 
any name data that does not match the found name pattern. The 
unmatched name data is stored in the pr_name_relation attributes. 

•   Street Ordinal Options - Do Nothing. The street ordinal option Do 
nothing (keep inputs) (which does not add or remove street ordinal) 
is now the default selection for all countries except US. 

•   Use TSS city table. Select this option if you want to use the city 
table provided by Trillium Software. This option is used when you 
create a user-defined template using a dummy city table (wwcity), 
and then subsequently purchase the country-specific city table.

•   Write misc data to neighborhood Option. Select this new option 
if you want to obtain neighborhoods when there is miscellaneous 
data identified between a street line and a geography line. The 
output is stored in the pr_neigh1 and pr_neigh2 attributes. (The 
option is selected by default for India (IN) and Hong Kong (HK).)

For more information in the TSS Help, see: Develop > Customer Data 
Parser > Setting Up the Customer Data Parser > Options > Specifying 
Advanced Customer Data Parser Settings > Advanced Customer Data 
Parser Settings.

 xxAUXCIT.ben/len File. In v15.0.0 there is a new optional ben/len 
file called xxAUXCIT (xx is the country code) which helps the Customer 
Data Parser verify that your input city/postcode is a valid combination. 

Basic Countries (ZZ), China (CN), United Kingdom (GB), 
Japan (JP), Korea (KR), Singapore (SG), and Taiwan (TW) do 
not support the xxAUXCIT file. 

The xxAUXCIT file will be delivered with the TSS country projects on a 
yearly basis and be included with the postal directory deliveries. 

Use the optional xxAUXCIT file to do the following:

•   Update/append province, city, and/or postcode information.
•   Validate province, city/postcode values and set additional flag (pr_

verified_geography) for most countries except CA/Canadian, NL/
Netherlands, and PT/Portugal (for which the xxAUXCIT table does 
not contain the full postcode).

•   For Hong Kong, if ISLAND name is available in the Province of NT, 
put the ISLAND name in the PR_SUB_CITY field.

The optional parameter AUXILIARY_CITY_FILE_NAME is exposed in 
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the Control Center through the Additional Geography Lookup option 
(see description above). For the US, this new check box will always be 
disabled and checked. For all countries other than US, if xxAUXCIT 
exists in the postal tables directory, the check box will be enabled and 
checked by default. If it does not exist, the check box will be disabled 
and unchecked. 

If AUXILIARY_CITY_FILE_NAME is present and the xxAUXCIT file exists, 
the new functionality will be applied to the Customer Data Parser. The 
AUXILIARY_CITY_FILE_NAME table will be enhanced to support 
countries that have at least two levels of geography (City, Province, and 
Postal Code).

 CDP Rule Change for India. Name patterns for the India CDPRUL 
table have been adjusted in v15 as follows: The CDPRUL contains a list 
of names which are always used as SURNAMES in the Northern and 
Central parts of India (names of people from the southern half of the 
country do not carry a SURNAME). If a name is a SURNAME it will be 
parsed as a SURNAME, otherwise it will be parsed as a GVN-NM.   

Example Patterns:

•   'ALPHA  SURNAME' will be parsed as 'GVN-NM1 SURNAME'
•   'ALPHA ALPHA' will be parsed as 'GVN-NM1  GVN-NM2'

 CDP Rule Table Updates. When applicable, the CPDRUL tables have 
been updated to include Province information to help with an improved 
Province/City validation routine.

 Japanese Customer Data Parser. When parsing Japanese data using 
the Japanese Customer Data Parser, the additional option One Person 
per Input Record? is now selected by default. 

When this option is selected, after the process runs the PNP_SINGLE_
PERSON_MODE setting will be set to Y. If you run the process without 
selecting When One Person per Input Record?, the PNP_SINGLE_
PERSON_MODE will be set to N. 

Directory Browser 
For v15, the Directory Browser (formerly named the Postal Directory Browser) 
has been enhanced. In addition to allowing you to view detailed information 
about addresses in your postal directories, you can now also browse your 
geocoding directories. The application has been renamed to Directory Browser. 

The Directory Browser can also be opened outside of the Control Center as a 
stand-alone application. This allows you to browse the postal or geocoding 
directories for a selected country without opening the Control Center.

The Directory Browser can be launched from both the Start menu and from the 
Control Center. 

 From the Start menu, select All Programs > Trillium Software > 
TSS 15 > Directory Browser. Select the country and browsing type, 
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Postal or Geocoding. When launched from the Start menu, you can 
browse the directories for all countries for which you are licensed.

 From the Control Center, in the Navigation or Project View right click the 
xx Postal Matcher (xx = country code) or xx Geocoder, select Edit 
Process, select the Tools tab, and click Launch Directory Browser. 
(For the zz Postal Matcher and zz Geocoder, a list of Basic countries 
displays. Select the country and click Continue.) Select the browsing 
type, Postal or Geocoding. When launched from the Control Center, you 
can browse the directories for the country from which the browser was 
launched.

For more information in the TSS Help, see: Develop > Directory Browser. 

Geocoder
 New Input Attributes. There are three new input attributes for the 

Geocoder process:

For more information in the TSS Help, see: Develop > Geocoder > 
Specifying Geocoder Options.

 US Census CBSA Changes. Notification was provided by Trillium 
Software’s data supplier that there are changes to the Core Based 
Statistical Areas (CBSA) data that was delivered in January 2014. As a 
result of this, you may see differences in your results and these are 
expected.

The changes include:

 51 new Core Based Statistical Areas
 77 retired Core Base Statistical Areas
 80 changes to Core Based Statistical Area Names
 130 new counties included in 100 Core Based Statistical Areas
 86 Counties removed from 76 Core Based Statistical Areas
 22 changes from Micropolitan to Metropolitan Statistical Areas
 2 changes from Metropolitan to Micropolitan Statistical Areas

Global Data Router
 Create empty output files for countries with no rows. This 

advanced setting now defaults to Y so that the Router generates zero 
byte output files when there are no output rows. This new setting 
prevents batch jobs from failing.

New Input Attribute Description

Sub City Sub city, district, suburb, neighborhood

Principality Administrative region

Extra City Small region (for example, Cedex in France)
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 Evaluate All Countries Option. If you want to evaluate the input 
entity against all possible countries and obtain the country codes, select 
the new Evaluate All Countries option. When selected, the Global Data 
Router will first evaluate the selected countries for the project, and then 
evaluate the rest of the countries defined in the Country Rules Table 
(rtrules2.win/unix) in alphabetical order. If it finds a record that 
would be routed to one of these countries, it will go to the No Match 
output with the real country code. For more information in the TSS 
Help, see: Develop > TS Quality Projects > Creating a Name and 
Address Project.

 Remove Customized Rule File. If you have uploaded and used your 
own advanced settings customer rules file, you can now remove it if it is 
no longer needed. This removes it from the settings file so that it will 
not be used the next time the process runs.

 Routing Country Flows. The Global Data Router now allows for 
routing of any country flow to another country flow, including individual 
basic countries and No Match countries. This "country flow override" 
feature can be used at creation of a Name and Address project, or 
applied later from the Global Data Router's country adjustment option. 

This is useful when you want to process a certain country's records 
using another country's process flow while maintaining the initial 
country code to identify the country of origin. For more information in 
the TSS Help, see: Develop > TS Quality Projects > Routing Country to 
Another Country.

 Use City Changes File Option. There is a new advanced option called 
use city changes file. When selected, in the Advanced Rules section of 
the GDR you then have the option to copy a city changes file to your 
system, customize it by adding entries to the REPLACE_CHARACTER 
and SWAP_WORDS parameters, and upload it again for use in the 
process. 

These entries instruct the process to use the specified characters and 
words to look up city names. By using this secondary table, the process 
can obtain better matching in table lookup. (The city changes file is also 
available in the Customer Data Parser.)

For more information in the TSS Help, see: Develop > Global Data 
Router > Editing Advanced Rule Files.

 Output City Changes for Selected Countries to Extended Debug 
File. In the Output Settings window, if you have selected Extended for 
the Debug option, you can optionally select a country or countries in the 
Output City Changes for Selected Countries section to dump the city 
changes to the debug file. Extended debug files contain information, 
such as dumping variables, used for troubleshooting purposes.
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For more information in the TSS Help, see: Develop > Global Data Router > 
Specifying Global Data Router Input and Output Settings.

Name and Address Analyzer
 You can now open the Name and Address Analyzer without having to 

open a TS Quality project.

Parser Tuner
 Open Error Log. The Open Error Log menu option allows you to open 

the log, stats, and exceptions files from within the Parser Tuner. You no 
longer need to navigate to the appropriate file directory on your 
system; the File Open window now uses the appropriate default file 
locations. For more information in the TSS Help, see: Develop > Parsing 
Rules Customization > Customizing the Parsing Rules > Reviewing 
Errors in Parsing Customization.

 Ignore Words Table. You can now open and work with an Ignore 
Words Table in the Parser Tuner. 

Postal Directory Browser
The Postal Directory Browser has been renamed Directory Browser. See 
Directory Browser on page 45.

Postal Directories
 Australia Postal Tables Delivery Schedule Changes. Trillium 

Software has increased the delivery frequency of the Australian postal 
files from four times per year to eleven times per year, February 
through December. 

 Hong Kong Postal Directory Changes. Beginning in June 2013, 
Trillium Software transitioned data sources for the Hong Kong postal 
directory. As a result, the new postal directories distributed by Trillium 
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Software will no longer include the Beat Number and Delivery Office 
fields which will be replaced by District Name.

 Singapore Postal Directory Changes. Updates to the Singapore 
Postal Directory were made available in June, 2013. The update 
includes how data is written to the Tq_gout_ext_key_1 attribute. 

 US Delivery Point Validation (DPV) Hash File. Starting with the July 
2013 delivery of the US postal directory for DPV processing, you will 
have the option to use a new single DPV hash file or the current 100 
DPV hash files. (See US Postal Matcher on page 53.) 

 US RDI Files. The USPS has made available their RDI product to 
vendors, including Trillium Software. Therefore, as of June 2013, 
Trillium Software started delivering US RDI files along with the regular 
release of the US Postal Directory files. Note the following:
 RDI identifies residential versus commercial delivery points to allow 

you to make an informed decision about the most cost effective way 
to ship a package to that address. 

 For a record to be processed through RDI, it must have matched the 
zip+4 directory and receive a zip+4 code.

 RDI can be run in a TS Director environment, but is not supported 
for CICS customers on the Mainframe.

 DPV/LACS does not need to be enabled to run RDI processing. 
 US Residential Delivery Indicator (RDI) Files Available. 

Residential Delivery Indicator (RDI) is a data product available from the 
United States Postal Service (USPS) that identifies a USPS delivery 
point as residential or commercial.

Postal Matchers
 TS_NEIGHBORHOOD. TS attributes are standard output attributes 

generated by the Postal Matcher process. There is a new TS attribute 
called TS_NEIGHBORHOOD. It has a length of 30 and its US source 
attribute is us_gout_urban_city_name. 

Asian Countries Postal Matcher
 Delete/Reset Review Groups. The Postal Matchers for China, Japan 

(standard), Korea, and Taiwan generate fail level codes (pr_geocode_
fail) for each row to indicate any potential problems. The fail level codes 
are associated with the review groups. For example, the fail level code 5 
(postcode failure) is generated when the review groups are 012 or 013.

If you do not want particular fail codes to be generated by the Postal 
Matcher, you can now disable them by deleting the corresponding 
review groups. For example, you can remove the fail code 4 by deleting 
the review group 001. 

 pr_block_number_display_full. There is a new attribute called pr_
block_number_display_full, with a length of 30, that contains block 
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number and block number indicators. Supports China, Korea, and 
Taiwan. 

Canada (CA) Postal Matcher
 New Data Encoding Option. There is a new option called Do not 

update house number when matching LVR addresses. By default, 
house number information is updated when the record matches an LVR 
(Large Volume Receiver) address. If you want to keep the original 
house number information, select this option. For more information in 
the TSS Help, see: Develop > Postal Matchers > Canadian (CA) Postal 
Matcher > How to Specify CA Postal Matcher Options. 

 New Output Attributes. There are four new output attributes for the 
CA Postal Matcher, described in Table 4-2. 

Custom Postal Matcher Options
 TQ_GIN_RECORD_TYPE. The Custom Postal Matcher attribute TQ_

GIN_RECORD_TYPE now returns E (Unknown street pattern) when the 
Customer Data Parser review code is 026.

 Equal Priority Option Removed for PO Box/Street priority. When 
working with the setting PO Box/Street priority (ADDRESS_PRIORITY) 
note that the third option (Equal Priority) has been removed. If you 
used Equal Priority in a previous version of TSS, the Postal Matcher now 
treats it as though it were the 1st option (PO Box gets priority over 
Street). This change affects the following countries: 

Table 4-2  CA Postal Matcher Output Attributes

Attribute Length Description

CA_GOUT_BASE_
FORMAT_FLAG

1 French or English formatting indicator based on the 
information in ca_gout_base_street_type. Values 
are:
1—English formatting (Street Name, Street Type, 
Street Direction)
2—French formatting (Street Type, Street Name, 
Street Direction)
This attribute is used in the default Transformer 

Data Reconstruction process. Canadian projects 
that were created in the previous version did 
not include this attribute. If an old Canadian 
project is imported or migrated and a new 
Transformer Data Reconstruction process is 
added, the user may need to add this attribute 
manually.

CA_GOUT_BASE_
STREET_DIR

2 Base street direction for alias street information.

CA_GOUT_BASE_
STREET_NAME

30 Base street name for alias street information. 

CA_GOUT_BASE_
STREET_TYPE

6 Base street type for alias street information. 
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•   Belgium (BE)
•   France (FR)
•   Malaysia (MY)
•   Netherlands (NL)
•   Portugal (PT)
•   Singapore (SG)
•   Spain (ES)
•   Switzerland (CH)
•   Luxembourg (LU)

France (FR) Postal Matcher
 New Output Attribute. There is a new France-only output attribute, 

TQ_GOUT_DELIVERY_ADDRESS_2, that stores the secondary 
address if a dual address is detected (for example, a CEDEX record). To 
use this attribute you must add it manually using the Schema Editor. 
The attribute length is 120.

Global Postal Matcher
 New Options. There are two new options available in the Global Postal 

Matcher:
•   Delivery Type. Specifying this option determines the type of 

delivery address. There are six types to choose from:

       - Pre-V15 functionality (default) - Delivery address and change   
         flags will not be filled. 
       - Street name, house number, sub building
       - House number, street name, sub building
       - Sub building, street name, house number
       - Sub building, house number, street name
       - Basic countries

•   Return Primary Alias. Specifying this advanced option returns 
aliases in the output. For example, with Austria, if you want to 
return the full sub building name which is available with the new 
Austria Post directory, select Sub Building. If the input is 
"HÜTTELDORFER STRAßE 127, 2   1140 WIEN, " the full sub building 
name "STIEGE 2" will be stored in the sub building attribute instead 
of just '2' in the output. 

 Default Global Postal Matcher Inputs. For v15, the Specify Input 
Lines section of the Global Postal Matcher is filled automatically, as 
follows:

By default, the Global Postal Matcher now uses Postcode, City, Region, 
Company (if any), plus the output address attributes from the 
Customer Data Parser such as Premise, Street, and PO Box as inputs. 
Specifying your own input attributes will override this default setting. 
Therefore, if you do specify input attributes, you must specify key 
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address attributes such as premise, street, and neighborhood to obtain 
satisfactory results.

 Performance Improvements. The parsing engine in the gaserver for 
V15 includes significant improvements for the Global Postal Matcher 
countries. To ensure backward compatibility, you have an option to use 
the pre-V15 parsing engine. To keep the same results as the pre-V15 
projects, add a line "UseNewParser = 0" to the Server section after the 
license directory line in the gaserver.ini file. The gaserver.ini file is 
located in /Software/bin.

Hong Kong (HK) Postal Matcher
 Change to HK Output Attributes. As of June 2013, the following 

output attributes are no longer generated in the Hong Kong Postal 
Matcher:
 HK_GOUT_DELIVERY_OFFICE
 HK_GOUT_BEAT_NUMBER 
 HK_GOUT_MATCHED_BLDG_ON_STREET
 HK_GOUT_POSTAL_CODE_CHANGED

Instead, the attribute HK_GOUT_CITY_NAME is used to write the postal 
district name output. 

Japan (JP) Postal Matcher (ACE)- New Stats File
 There is a new statistics file available for the JP Postal Matcher for ACE. 

This new file expands the summary data returned by the Postal 
Matcher, identifying the conditions found during the process by 
reporting normalization results and details of normal and error 
addresses.

Luxembourg (LU) Postal Matcher
 Street type match. The setting Street type match for LU has been 

changed from N (off) to Y (on) by default. This new default enhances 
performance results. 

Netherlands (NL) Postal Matcher
 New Custom NL Postal Matcher Option. There is a new custom 

Postal Matcher option available for Netherlands (NL) called Validate 
address using postal code and house number. When this option is 
checked in the NL Postal Matcher, a match is performed using the postal 
code and the house number.

Singapore (SG) Postal Matcher 
 Updates to Singapore Postal Directory files were released in June, 2013. 

If you are using the updated postal directories, and you have defined 
the attribute Tq_gout_ext_key_1, the way the first byte populates has 
52 TSS v15 Release Notes



TSS v15.0 Data Quality Enhancements
changed. For more information in the TSS Help, see: Reference Material 
> Postal Matcher Attributes > Custom Postal Matcher Attributes.

UK (GB) Postal Matcher
 New Attributes. There are two new attributes for the GB Postal 

Matcher:
•   gb_gout_delivery_address. Stores the first line of delivery 

address. 
•   gb_gout_delivery_address_2. Stores the second line of delivery 

address. 

For more information in the TSS Help, see: Reference Material > 
Postal Matcher Attributes > United Kingdom (GB) Postal Matcher 
Attributes

US Postal Matcher
 City Centroid Option. The US Postal Matcher now returns latitude and 

longitude coordinates accurate to the center point (centroid) of a city. 
This feature is enabled on the US Postal Matcher's Options tab by 
selecting City Centroid.

 DPV Source File Arrangement Option. The US Postal Matcher has a 
new DPV option called DPV Source File Arrangement. This option has 
two choices, Multiple and Single:
 The Multiple option uses the standard 100 DPV files (dph.hsa.z00-

z99—100 segmented DPV hash tables).
 The Single option uses the single DPV file (dph.hsa—single hash 

table). This file was introduced in the July 2013 delivery of the US 
postal directory for DPV processing. 

For more information in the TSS Help, see: Develop > Postal Matchers 
> United States (US) Postal Matcher > Specifying US DPV Options.

 Include DPV PO Box Street Address Table Option. The US Postal 
Matcher has a new Delivery Point Validation (DPV) option called 
Include DPV PO Box Street Address Table. Select this option when 
using the PO Box street addresses (dph.hsp) table. This tells the Postal 
Matcher to add the new US_DPV_PBSA attribute to the output schema.

 Street Latitude and Longitude. The US Postal Matcher interpolates 
latitude and longitude coordinates for a specific house number based on 
the house number range for the street. This feature is now enhanced to 
return the latitude and longitude of the beginning of the street if the 
house number is not within the house number range.

Relationship Linker
 New Modifiers. To ensure compatibility with Series 7, the new modifier 

S7 has been added to the Relationship Linker. The S7 modifier applies 
the same algorithm as in Series 7 to the Partial2 and Soundex routines. 
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Use the new modifiers when you want to obtain the same linking results 
as Series 7. For more information in the TSS Help, see: Reference 
Material > Relationship Linker Comparison Routines. 

 Update to PARTIAL2 With Modifier (STATUS) Routine. The 
STATUS modifier is used with the PARTIAL2 routine to compare fields of 
two (2) different records for a specified literal value. The syntax of the 
PARTIAL2 With Modifier (STATUS) routine has been modified if you use 
this modifier with the MATCH function in the Expression Builder as 
follows: 

MATCH("PARTIAL2", attribute1, attribute2, "STATUS=literal_value")

where

 attribute1 is the attribute whose value you want to compare.
 attribute2 is the attribute against which attribute1 is compared.
 literal_value is the value to check.

Schema Editor
 Auto Adjust Max Width. There is a new option in the Edit Output 

Attribute window called Auto Adjust Max Width. The Auto adjust 'Max 
width' option affects the behavior of the attribute redefinition operation 
depending on whether the option is checked or cleared. (This option is 
cleared by default.) For more information in the TSS Help, see: Develop 
> TS Quality Processes > Schema Editor > Redefining Attributes > 
Redefining Attributes by Drag-and-Drop.

 Encodings. EBCDIC has been added to the list of supported encodings 
in the Schema Editor. 

 Input/Output Attribute Filter. In the Schema Editor, you can now 
search and filter attributes and substrings in attributes to display the 
input and output schemas. 

 Redefining Attributes with Drag and Drop. When an input attribute 
is mapped to an output attribute smaller in width, a message box 
displays. Click Yes to use the new, larger width. Click No to continue 
using the original smaller width. If you choose to use the original width, 
the value of the output attribute may be truncated.

Set Selection Utility
 DEDUPE. There is a new Quality function called DEDUPE, for use in the 

Transformer process and in the Set Selection utility. DEDUPE separates 
the value in an attribute into tokens and returns the deduped and 
delimited list of tokens. 

 New Output Option. Set Selection output settings enable you to 
customize the values that the utility uses to output records. There is a 
new output option for group sequence numbering called Attribute to 
use for group sequence which sets the attribute that will be 
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populated with the group sequence number within the current set. The 
parameter for this option is SET_SEQUENCE_FIELD_NAME. 

Transformer
 DEDUPE. There is a new Quality function called DEDUPE, for use in the 

Transformer process and in the Set Selection utility. DEDUPE separates 
the value in an attribute into tokens and returns the deduped and 
delimited list of tokens. 

 If Statements. The maximum number of IF statements allowed for 
each settings file is now 4000. The following guidelines still apply:
 An IF condition must be defined as a test within parentheses. 
 There is a maximum of 100 nested IFs allowed in each IF statement. 
 Adding multiple IF keywords to the top level of a single conditional 

section is not supported. Include only one top-level IF (head-if) per 
section. 

 Output Conditionals. You can now select input and/or output 
attributes whenever you specify conditions or attribute transformations 
using the Expression Builder within a Transformer's Output 
Conditionals. The input attribute names will be preceded by the entity 
name associated with the input. 

 PROCESS_SAMPLE_COUNT. If a PROCESS_SAMPLE_COUNT value is 
specified for a Transformer that has been configured to produce 
delimited output, the value will be used for both the fixed and the 
delimited output.

 Run Statements. When the Control Center groups multiple RUN 
statements for attribute scans and table recodes into a single RUN 
statement, it now uses commas to separate items and hyphens to 
indicate ranges. This allows a more robust and efficient method to 
group multiple RUN subroutines for running in sequence. 

The following example shows a RUN statement before and after 
grouping using commas and hyphens:

Before:

IF (ALWAYS) IF (ALWAYS) RUN FIELD_SCANNING(2) RUN FIELD_
SCANNING(4)  RUN FIELD_SCANNING(5)  RUN FIELD_SCANNING(7)  
RUN FIELD_SCANNING(8) ENDIF ENDIF
After:

IF (ALWAYS) IF (ALWAYS) RUN FIELD_SCANNING(2,4-5,7-8) ENDIF 
ENDIF

 Table Recode—Maximum Attribute Length. The maximum attribute 
length for table recodes has been expanded to 2000 bytes (1000 
characters in UCS2).

 Table Range Function. The new Table Range function in the 
Transformer allows you to validate data by performing a look-up on up 
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to five attributes, followed by a range check on an attribute if the look-
up is successful. You can also recode up to five attributes if both the 
look-up and the range check are successful. Recoding is optional. This 
function is useful when you are testing A + B = C where C is in a range. 
Find more information in the TSS Help, see: Develop > Transformer > 
Validating Data Using Table Range.

 Table Range and Table Recode—New Option. When generating a 
file-based recode table or validating data using the table range function, 
there is a new option called Character to use as a comment 
indicator which instructs the Transformer to ignore any lines in the 
recode table that start with the character specified in this option. For 
more information in the TSS Help, see: Develop > Transformer > 
Validating Data Using Table Range > Using Table Range and Develop > 
Transformer > Recoding Data Using Tables > File-based Recode Tables.

 Trace Key Setting. The Trace Key setting has been removed from the 
Transformer. Note the following behavior:
 For newly created and imported projects, the entry FILE_TRACE_KEY 

will no longer be included in the tsd or stx file. 
 For legacy projects (projects created before TSS v14.4), the entry 

FILE_TRACE_KEY still remains in the tsd and stx file. It can be 
removed by exporting and importing the project.

 Transformer Data Reconstruction. 
•   New Derived Attributes. Derived attribute values are determined 

by the country’s Transformer Data Reconstruction process. The 
following new derived attributes have been added to all country 
templates:
- dr_Neighborhood
- dr_Country Code

•   Business Data and Empty Projects. The Transformer Data 
Reconstruction process is not included by default in Business Data 
and Empty projects, but you can now insert it into these project 
types. The process is configured without any default rules and you 
can enter your own conditional logic.

 Transformer Unified Output - Saved Country Output Attribute. In 
previous versions of TSS, the Saved Country output attribute generated 
by the Global Data Router was not included in the output of the 
Transformer Unified Output and had to be manually added to the output 
schema in every country's Transformer Unified Output. Now it is 
included in all country templates so you don't have to manually add this 
attribute. 

The Saved Country attribute contains the country code such 
as US and CA. 
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 Web Service Calls. The Transformer allows you to call certain XML-
based web services in the Control Center, batch and real-time 
environments. For example, using the Transformer you can call a third-
party web service to obtain GPS coordinates or you can call a web 
service to generate reverse phone and address information. 

Note the following guidelines:
•   You select the web services attributes to be generated in the output 

schema by mapping the input attributes of the web services to 
output attributes. 

•   By inserting the Transformer process into your Quality project, you 
can also use the output of the web service as the input for the next 
process in the project.

•   Map files are required to use web services. They contain all the 
information required to define a specific web service call and its 
corresponding response. (Map files are encrypted, external files 
provided by Trillium Software and installed with the TSS software.) 
You need one map file for each web service for which you have a 
valid subscription. 

•   Supports REST calls only (SOAP calls are not supported).

For more information in the TSS Help, see: Develop > Web Service 
Calls.

Window Keys
 New Rules. To ensure compatibility with Series 7, four new window 

key rules (OS2, IS2, ROS2, and RIS2) have been added. Use the new 
rules for the primary and secondary window key codes when you want 
to keep the same window keys as Series 7. For more information in the 
TSS Help, see: Develop > Window Keys > Selection (Primary/
Secondary Field Code).

 SOUNDEX Routines. All SOUNDEX-related routines are limited to 
working with attribute sizes of 256 characters. Now when the attribute 
length exceeds 256 characters, the algorithm will be applied to the first 
256 characters for all SOUNDEX routines. For all RSOUNDEX routines 
the algorithm will be applied to the last non-blank 256 characters.

Window Key Generator
 vcnmasks.win/unx Mask Files. The mask files vcnmasks.win/unx 

used by the Window Key Generator process (variations: grvcnmask, 
trvcnmask) include encoding specific entries such as Latin1, Latin2, 
Greek, and so on. grvcnmask and trvcnmask files are the same as 
vcnmasks and are provided for backward compatibility with pre-v15 
functionality. 
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CHAPTER 5

TSS v15.0 Project Import/Export 
Enhancements

This chapter describes the enhancements and changes incorporated into the 
following functionality used to import and deploy TS Quality projects:

 Exporting Quality Projects on page 58
 Real-Time Project Deployment on page 59

Exporting Quality Projects

Project Deployment
 Quality project deployment is now run as a background task. 
 Project deployment will only run if TS Quality is installed on the client 

system. Attempting to run deployment on a system where TS Quality is 
not installed will generate a message alerting you to this. 

Batch Deployment Tool
 The Batch Deployment Tool (BDT) will only run if TS Quality is installed 

on the client system. Attempting to run the BDT on a system where TS 
Quality is not installed will generate a message alerting you to this. 

Deploying/Exporting to Batch
 Analysis Process. When you export a project containing an Analysis 

process into a batch script, the Analysis process will run as part of the 
batch execution. For more information in the TSS Help, see: Develop > 
TS Quality Processes > Profiling Processes > Using the Analysis 
Process. 

 Batch Delimiters. ESC has been added to the list of input and output 
delimiters in the batch export window. 
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 Deploying Legacy Quality Projects. You cannot deploy the following 
types of legacy projects (created before TSS v13) to real-time, only to 
batch: 
 Name and Address
 Empty
 Business Data

 Specifying Quote Characters. If your input entity contains delimited 
data, upon batch export quote characters will be set to the quote 
character you specified when you created the entity in the Create Entity 
Wizard. 

 Original Input Delimiter—New Quotes Option. For batch project 
exports there is a new option called Quotes which, when set, allows 
using unmatched quotes as qualifiers for delimited input file. For more 
information in the TSS Help, see: Deploy > Exporting a Project to a 
Batch Script.

 UCS2 Encoding Option. For purposes of efficiency, when you export a 
project to batch, in the Export Project Options window, under Script 
Options, there is a new option Use UCS2 Encoding. If you select this 
option, all files, apart from inputs and final outputs will use UCS2 
encoding. 

 UTF8. Batch exports no longer apply the UTF-8 multiplication factor to 
the attribute lengths in the input ddx file(s) when the input data is fixed 
length.

Exporting Project Definitions
 Server Build Information. The TSS server version build information is 

now included in the project.xml file in an exported Quality project. To 
see the information, uncompress the .prj file using a compress/
uncompress tool such as Winzip and open the project.xml file in a text 
editor. The build stamp is displayed in the <server_build> entry.

Real-Time Project Deployment
 Automatic Reference or Window Match. The default Name and 

Address project template includes a Relationship Linker process. When 
you deploy a project for real time, the deployment process 
automatically prepares the project to perform either a reference match 
or a window match, depending on how your client calls the matcher. 

For example, if you call the match() method, a window match is 
performed. If you call the matchCandidate() method, a reference 
match is performed.

 Deploying Non-Legacy Projects. You can now publish and deploy 
non-legacy empty and/or business data projects to real-time. When 
working in the Project Deployment Manager, the project type is 
identified in the Project Deployment Form under Connector Type. 
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 Projects Unsupported for Deployment. You cannot deploy the 
following types of legacy projects (created before TSS v13) to real-
time: 
 Name and Address
 Empty
 Business Data

 MATCHER_USER_KEY Attribute. The real-time project deployment 
process now automatically creates the MATCHER_USER_KEY attribute, 
which is used to uniquely identify records during the match process.  
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CHAPTER 6

TSS v15.0 Data Management 
Enhancements

This chapter describes the enhancements and changes incorporated into the 
following TSS data management products:

 TS Case Management on page 61
 TS Reporting Adapter on page 62
 TSS Repository Manager on page 62

TS Case Management
TS Case Management is an add-on that extends Trillium Software’s data 
quality management capability by providing the ability to open and manage 
data exception cases for data remediation, process modification, and issue 
management. Pre-built and administrator-defined projects help organize your 
cases depending on your business needs. 

The TS Case Management process involves:
 Finding:

•   targeted data conditions (business rule exceptions) by running entity 
business rules (EBRs).

•   data anomalies through regular data analysis review.
 Creating a case based on the results of the findings and associating it 

with a Case Management project.
 Managing the case from a browser-based dashboard.

For information about installing and using TS Case Management, see TS Case 
Management Installation & User Guide.
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TS Reporting Adapter
The TS Reporting Adapter (formerly the TS Insight Connector) is a callable 
data reporting provider designed to run TSS table queries that extract the 
contents of a TSS repository and import the data as a table into supported 
third-party applications and dashboards. 

The reporting adapter has been enhanced as follows:
 Supports both OLE DB and ODBC data connections. 
 Dozens of queries have been added, increasing the range of data that 

you can extract from a TSS repository and import into a third-party 
application. 

 Each adapter now has a separate license which has removed the 
dependency on the availability of sufficient user, reporting, repository, 
and task tokens to properly run queries over configured data 
connections. 

 Ten customized TSS Excel sample reports are available for use with OLE 
DB Data Provider. 

 The TS Reporting Adapter supports the following applications and 
dashboards:
•   OLE DB Data Provider: Excel, QlikView Business Discovery Platform 

dashboard, Query Express, and SQL Server.
•   ODBC Data Provider: Any 32-bit software that supports ODBC 

connectivity, including Excel, QlikView Business Discovery Platform 
dashboard, and Tableau.

Guidelines
Note the following:

 The ODBC Data Provider for 32-bit is available with the TSS software 
package although it is installed separately. The OLE DB Data Provider is 
installed with the TSS client software.

 If you are planning to use the OLE DB Data Provider with a 64-bit 
version of Excel, you must install the 64-bit version of the OLE DB 
Provider. The OLE DB Provider (64-bit) is available with TSS software 
package, although it is installed separately.

 The TS Reporting Adapter supports Excel 2010 and 2012.
 For more information about using the TS Reporting Adapters, see the TS 

Reporting Adapter for Excel User’s Guide. 

TSS Repository Manager
This section describes enhancements and changes to the Repository Manager 
as well as scripts and commands run in Repository Administrator Command 
Prompt. 
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For additional information about TSS administrator tasks and 
working with the Repository Manager, see the TSS Repository 
Administrator’s Guide. 

 Customized Note Classes and Subclasses. The TSS repository 
administrator can now create customized classes and subclasses for 
Control Center notes. When creating notes in the Control Center, users 
can select from the user-defined class and subclasses created by the 
administrator or from the default class and subclasses. For more 
information, see the TSS Repository Administrator’s Guide. 

 Berkeley Database Utilities. A set of command-line utilities is 
installed in the server’s bin directory. These are available to help 
troubleshoot the Berkeley database, which stores TSS data, metadata, 
and associated database files.

These utilities should be used in conjunction with Trillium Software 
Customer Support. For more information and a document describing 
how to use each utility, contact Customer Support (see Trillium 
Software Resources on page 10). 

 Change Default Job Name. TSS administrators have the option to run 
an mtb_admin command to change a default name. The syntax is: 
renamejob job_ID new_job_name
Where 

 job_ID represents the unique reference number for the job as 
displayed in the Background Tasks List View.

 new_job_name is the new job name.  
 DB2 10 Relational Data Source. DB2 10 is now a supported database 

client. 
 Export Command—New Parameter. There is a new, optional 

parameter for the mtb_admin export command called parent_eid. Use 
this parameter to specify the ID of the entity parent of the entity you 
want to export. For example, 
export failing_rows entity 1 br_name test filename /export/ 
   testfile filetype txt parent_eid 2

 Fix Rule mtb_admin Command. Running this command will update 
every rule in the current repository, and will return the rule IDs whose 
expressions have been changed. Every rule in the repository will 
become out-of-date and will need to be re-analysed.

The fixRules command has two optional parameters:

-verbose. Prints to the console every rule ID being checked, so you can 
monitor progress.

-quiet. Prints nothing to the console.

By default it will show the rule IDs that have been changed.
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 Hadoop Hive Data Connection. You can now load data into the TSS 
repository with a TSS ODBC (Trillium-supplied) Hadoop Hive driver. 
Table 6-1 describes the Hadoop environments supported by the TSS 
v15 Hadoop Hive driver. 

Note the following guidelines:

 The Hadoop connection is read only, you cannot write back to the 
database using a Hadoop connection.

 The TSS 15 Hadoop Hive Driver supports both Windows and UNIX 
systems. 

 Locale Repository Setting. When adding a repository, there is a new 
option called Locale which allows you to select a desired locale (your 
unique language or region identifier) to use for your collation method. 
Keep the default option as Original if you use the non-collated sort 
method. 

 New Load Connection Settings:
•   Run Statistics at Load Time. There is a new loader connection 

setting called Run Statistics at Load Time (selected by default). 
When selected, during data import TSS automatically performs 
statistical analysis of attributes with numeric values to calculate the 
standard deviation value. If statistical analysis is not run during data 
import, users can manually run the analysis for one or more 
attributes in the Control Center.

•   Enable/Disable Standard ABRs. The Standard library attribute in 
the Control Center contains ABRs that act as universal compliance 
checks for attributes. There is new a loader connection setting called 
Copy standard attributes business rules to attributes (cleared 

Table 6-1  Supported Hadoop Hive Environments

Environment Distribution Version Hadoop Hive Version

Amazon Elastic MapReduce 
(Amazon EMR)

N/A Hive 0.8.x
Hive 0.11.x

Apache Hadoop Hive N/A 0.8.x
0.9.x
0.10.x
0.11.x
0.12.x

Cloudera’s Distribution Including 
Apache Hadoop (CDH)

CDH3 update 4
CDH4.0x
CDH4.1
CDH4.2
CDH4.5

Hive 0.7.1
Hive 0.8.x
Hive 0.9.x
Hive 0.12.x

Hortonworks Distribution for 
Apache Hadoop

HDP 1.3 Hive 0.11.x

HDP 2.0 Hive 0.12.x

MapR Distribution for Apache 
Hadoop

MapR 1.2
MapR 2.0

Hive 0.7.1
Hive 0.9.x
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by default). When selected, attribute business rules in the Standard 
library attribute are automatically copied to attributes when entities 
are created for the current repository.

 Updated Load Connection Terms. To better align the available data 
load connections, the following changes to terminology have been made 
to the Add Loader Connection window:

Table 6-2  Load Connection Term Changes

Old 
Term

New Term Description

COBOL COBOL Flat Fixed Length Files This option allows you to connect to 
flat, fixed-length files described by 
COBOL copybooks. The data must 
match copybook layout.

DB2 DB2 (Vendor Supplied) This option allows you to connect to 
DB2 databases.

Delimited Delimited Files This option allows you to connect to 
any delimited files with ASCII, 
extended ASCII, or hexadecimal 
delimiters. Also with or without ANSI 
SQL DDL.

ODBC ODBC (Vendor Supplied) This option allows you to connect to a 
number of databases using ODBC driv-
ers supplied by database vendors. 
Choose this option if you are connect-
ing to a data source which is unavail-
able through TSS ODBC. For more 
information about supported data-
bases, see the TSS Repository Admin-
istrator’s User’s Guide.

Oracle ORACLE (Vendor Supplied) This option allows you to connect to 
Oracle databases. This connection 
requires the Oracle client to be 
installed.

Trillium Trillium Flat Files This option allows you to connect to 
flat files created by TSS modules when 
they process data.

Generic TSS ODBC (Trillium Supplied) This option allows you to directly con-
nect to the widest selection of external 
databases, including Oracle, DB2, SQL 
Server, Informix, Teradata, Sybase, 
Greenplum, Hadoop Hive, and many 
others, without having to install ven-
dor-supplied drivers.
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CHAPTER 7

TSS v15.0 Enterprise Integration 
Enhancements

This chapter describes enhancements and updates for the following TSS 
enterprise data products:

 TS Director on page 66
 TS Director - CICS on page 67
 TS Web Services on page 68
 TS Connector for SAP Products on page 68

For information about real-time deployment, see TSS v15.0 Project Import/
Export Enhancements on page 58.

TS Director
This section describes enhancements and changes to the TS Director 
components, including the Project rule Analyzer. For more information about 
TS Director, see the TS Director User’s Guide. 

 Default Component Port Numbers. Default port numbers for all ECS 
components have been changed and are now prepended with the 
product version number. For example, the default Director port is 
15000, the default Monitor port is 15005, the default SDK Cleanser port 
is 15010, and so on. This simplifies installation of multiple versions of 
ECS components on the same server.

 Identify Component Version Numbers. The version number of each 
ECS component is now displayed. For user interface components, the 
version number displays in the title bar of the main window. For 
servers, the version number is displayed with the Director System 
Manager's Investigate option and Properties option.

 View Street Names and Street Details. For GB and US projects that 
include the Display street details in real-time and/or the Display detail 
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buffer in real-time options, you can now view the content of these 
buffers in the Project Rule Analyzer (PRA). 

 Clone Cleanser and Matcher Servers. In the Director System 
Manager you can create multiple cleanser and matcher servers for a 
project by cloning a server. Using multiple cleansers and matchers 
improves performance and allows for failover if a server becomes 
unavailable. 

Cloned servers will share project resources (settings files, DDLs, postal 
directories, and so on) but will use separate log and exceptions files. 
The Director System Manager will create a separate connector 
configuration file (trillium.cfg) and token configuration file 
(config.tbl) for each server.

 Director SDK Documentation. The information in the TS Director SDK 
Reference Guide has been modified as follows: the XML-over-HTTP, NET 
Web Services, and J2EE chapters have been removed and are now 
available in three separate documents:
•   TS Director XML-Over-HTTP Developer’s Guide
•   TS Director IIS .Net Web Services Developer’s Guide
•   TS Director J2EE Interface Developer’s Guide

 Integrated Configuration Manager (ICM). The Integrated 
Configuration Manager (ICM) sample text has been removed from 
TrilXML.cfg and the configuration button has been renamed to 
remove reference to ICM.

 Real-Time Projects. The TrilXML.cfg XML mapping file has been 
changed to include a new Update Object Section, XMLAddress1, which 
contains only one entry. This change enhances performance when 
running a large record set combined with a large set of fields.

 Samples. For v15, enhanced samples are provided for the TS Director/
SDK. For more information, see TS Director SDK Reference Guide. 

TS Director - CICS
The new TS Director - CICS solution allows the TS user to make client calls 
from an IBM Mainframe system running CICS (middleware that processes high 
volume transactions) and communicate with TS Director running on an ASCII 
(UNIX or Windows) system. 

The TS Director - CICS solution uses XML streams over HTTP protocol to 
transmit data between CICS and the TS Director. The solution is available in 
TSS v14.0 and later versions. It requires:

 CICS TS v3.1 and later versions (with CICS sockets enabled)
 TS Director v14.0 and later versions running on a UNIX or Windows 

platform

For information about installing and using TS Director - CICS, see the TS 
Director - CICS Installation Guide and the TS Director - CICS Reference Guide. 
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TS Web Services
TS Web Services is a new, optional component of Trillium Software’s 
Enterprise Connectivity Solutions (ECS). TS Web Services allows you to use 
industry standard tools and protocols, such as XML, SOAP, and HTTP, to send 
records to the TS Director to be cleansed (formatted and enhanced) and 
matched (identify potential duplicates).
You define the format of cleansing and matching requests with the XML-based 
Web Services Description Language (WSDL). The Web Service Configuration 
and Deployment Manager guides you through the process of creating, testing 
and deploying your cleansing and matching WSDLs.

The TS Web Services installation includes sample WSDLs and requests 
developed with the sample TS Quality project supplied with the TS Director. 
You can use these samples to become familiar with TS Web Services. 

Launch the Web Services Configuration and Deployment Manager from the 
Director System Manager by selecting File > Launch Web Service 
Configuration and Deployment Tool.

Code Sample and Sample Projects. In v15, the location of the code 
samples and sample projects has been changed to make them more easily 
accessible. The samples have also been modified: C/C++ samples now use 
MSVC 2013, C# samples (and .DLL's) now use .Net 4.0, Java now uses v1.7, 
and additional configuration is required to for WebLogic 11.g (see the 
ReadMe.txt file in Web Services > WebLogic folder).
For more information, see the TS Web Services User’s Guide.

TS Connector for SAP Products
This section describes enhancements and changes to the TS Connector for SAP 
products. For more information about the TS Connector for SAP, see the TS 
Connector for SAP Products Reference Guide. 

 The /TRILLIUM/RSADRINI report has been enhanced to include the 
country as filter criteria and performance has been improved by way of 
parallelization.

 User Exits/BADIs are now provided in Master Data Tools for Master Data 
Inquiry and Batch Window Matching.

 Support for CRM 7.0 Enhancement Package 3 (EHP3) and ERP 6.0 
Enhancement Package 7 (EHP7).

 Re-certified the SAP Connector for both PV (Postal Validation) and DES 
(Duplicate Check and Error Tolerant Search).
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CHAPTER 8

TSS v15 Update 1 Enhancements

This chapter describes the enhancements and updates included in the first 
update to TSS v15 (released October 2014), including:

 Data Quality Enhancements on page 69
 Data Management Enhancements on page 70
 Enterprise Integration Enhancements on page 71 

For a full list of changes incorporated into the update, see the patch 
logs available with your TSS update downloads. 

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes.

Transformer Table Recode
The UI option Enable phrase change has been changed to Phrase Recode 
Only to make it clear that it recodes only the look-up value itself, not the 
entire attribute. There is no change in the way the function works. 

United Kingdom (GB) Postal Matcher
Changes and additions have been made to the GB Postal Matcher output 
schema, UI options, and browser fields. 

Output Schema Changes
 The length of the attribute Gb_gout_organization_name has been 

changed from 30 to 60 characters. The attribute stores the extended 
version of the business organization name. 
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 New Gb_gout_udprn attribute stores a UDPRN (Unique Delivery Point 
Reference Number), an 8-character numeric code to identify the PAF 
addresses. 

 New Gb_gout_department attribute stores the department name. 60 
characters.

Use Postal Extensions Option
There is a new UI option called Use Postal Extensions. When checked, the 
postal extension table (GBEXDATA.tbl) is used to generate the department 
names (gb_gout_department) and the extended version of the organization 
names (gb_gout_organization_name). 

The postal extension table is included in the GB postal directories. The 
argument in the settings file is POSTAL_EXTENDED_DATA_FILE_NAME.

The postal extension table (GBEXDATA.tbl) must be installed to 
use this option. The postal extension table is included in the GB 
postal directories delivered in September 2014 or later.

GB Directory Browser Field Changes
 ORGANIZATION_NAME. The organization name field length has been 

changed from 30 to 60 characters.
 New field UDPRN (Unique Delivery Point Reference Number) contains an 

8-character numeric code to identify the PAF addresses. 
 New field DEPARTMENT contains the department name. 60 characters.

To display the department names and the extended version of 
the organization names, the postal extension table 
(GBEXDATA.tbl) must be installed. The postal extension table is 
included in the GB postal directories delivered in September 
2014 or later.

If you import or migrate your old or legacy projects after installing 
v15 Update 1, the new attributes and attribute length will be 
automatically applied upon import or migration. If you import or 
migrate your old or legacy projects in v15 and then install v15 
Update1, the new attributes and attribute length will be applied 
when you run the GB Postal Matcher process.

Data Management Enhancements
This section describes the enhancements and changes incorporated into the 
Repository Manager and the TS Reporting Adapter. 

Local System Restricted Access Option
As an enhancement for repository security, TSS administrators can now limit 
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the access TSS users have to copy or export files from a repository to their 
local systems or to a network. 

The new option, Disable access to the file system, is available in the 
Options window in the Repository Manager. When selected, this option limits 
users to write data back to the repository only.

Selecting the option disables the following tasks:
 In the Repository Manager and Control Center:

•   Session options New, Open, Save Session, and Save as 
•   Save, Export, and Copy a List View to local system
•   Save List View Layout, Load Layout and Export 
•   The Quick Access Toolbar and related icons (for example, Open, 

Save and Print)
•   Access to technical documentation

 In the Control Center:
•   In the Library, the export to local file system or import from local file 

system for Business Rules, Word definitions, and Ignore words 
tables

•   Export and Generate Schema options for entities
•   Import project for TS Quality projects and Generate DDL for TS 

Quality entities
•   On the Advanced tab, the Edit Schema button

For more information, see the TSS Repository Administrator’s Guide.

64-bit Support for ODBC TS Reporting Adapter
The TS Reporting Adapter now supports connections to 64-bit applications, 
such as Excel. The ODBC Reporting Adapter (64-bit) is available with the v15 
TSS installation package. 

For more information and installation procedures, see the TS Reporting 
Adapter for Excel User’s Guide. 

Enterprise Integration Enhancements

Director .NET Wrapper API
As part of the TS Director SDK solution, the Director .NET Wrapper API 
provides functions that give you access to the data cleansing and matching 
services of Trillium Software System. For TSS v15 Update 1 there are two new 
Director .NET Wrapper classes available:

 WinServiceManager. Provides methods to create, start, stop and delete 
Windows services for the cleanser and matcher. 
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 WinServiceParameters. Provides the parameters necessary to create, 
start, stop and delete cleanser and matcher services. There are no 
methods; the class contains the properties for setting the parameters.

For more information, see the TS Directory SDK Reference Guide.
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CHAPTER 9

TSS v15 Update 2 Enhancements

This chapter describes the enhancements and updates included in the second 
update to TSS v15 (released February 2015), including:

 Control Center Minimum Requirements on page 73
 Trillium Cloud on page 74
 Expression Builder - New Date Functions on page 74
 Data Quality Enhancements on page 75
 Data Management Enhancements on page 75
 Enterprise Integration Enhancements on page 77 

For a full list of changes incorporated into the update, see the patch 
logs available with your TSS update downloads. 

Control Center Minimum Requirements
This section includes the requirements for the Control Center client, with 
changes noted for this update. 

Supported Platforms
 Microsoft Windows 8
 Microsoft Windows 7
 Microsoft Windows Server 2012
 Microsoft Windows Server 2008

Windows Vista and Windows Server 2003 are no longer supported. 

Browser Support
Internet Explorer versions 9, 10, and 11 are supported. 

IE 8 is no longer supported. 
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Trillium Cloud
Trillium Cloud allows you to work with TSS data quality profiling and cleansing 
tools in a cloud environment. With Trillium Cloud you do not need to install 
TSS software on your server systems, apply patches and upgrades, or install 
and maintain country templates and directories. 

Features include:
 Access to the Control Center, Parser Tuner, and Directory Browser data 

quality tools
 Ability to view, edit, and execute TS Quality batch projects exported 

from the Control Center
 Ability for TSS administrators to add and configure data (loader) 

connections, add data repositories, and set repository permissions 

Expression Builder - New Date Functions
The following functions have been added to the Expression Builder. These 
functions enhance how TSS handles dates in expressions. 

 DT_ADD. Increments (or decrements) part of the date or time and 
returns a string with the date/time in the same format.

 DT_CEILING. Updates the date/time to the end of the specified part 
and returns a string with the date/time in the same format.

 DT_CONVERT. Converts date/time value from its original format to a 
specified format and returns a string value.

 DT_DIFF. Calculates the difference between two date/time values.
 DT_DIFF_PART. Returns the approximate difference between the 

specified part of two date/time values as an integer.
 DT_IS_DATE. Evaluates whether the date/time value is a date.
 DT_IS_DATE_TIME. Evaluates whether the date/time value is in the 

specified format.
 DT_IS_TIME. Evaluates whether the date/time value is a time.
 DT_MAX. Compares two date/time values to determine which is later. 
 DT_MIN. Compares two date/time values to determine which is earlier. 
 DT_NAME. Extracts the specified part of the date/time and returns the 

localized name. 
 DT_NOW. Returns the current date/time in the specified format.
 DT_PART. Extracts the specified part of the date/time and returns the 

value as an integer. 
 DT_ROUND_DOWN. Rounds down the specified part of a date/time 

and returns a string with the date/time in the same format.
 DT_ROUND_UP. Rounds up the specified part of a date/time and 

returns a string with the date/time in the same format.
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 TO_SECONDS. Returns the specified date and time as seconds.

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes.

City Changes File
The city changes file is an advanced file used in the Customer Data Parser and 
the Global Data Router. Entries in the file instruct the process to use the 
specified characters and words to look up city names. 

When used with the Customer Data Parser, there is a new entry available in 
the list of attributes for GEOGRAPHY lines of patterns called GEOG-CHANGE 
(abbreviated to GEOG-CHG). Corrects mismatched province and city values, 
as well as spelling of a city name.

US Postal Matcher 
The new Postal Service code PB is generated in the US DPV attribute us_dpv_
footnote3 for the US Postal Matcher if the input address matches the PBSA 
table. 

Data Management Enhancements
This section describes the enhancements and changes incorporated into the 
Repository Manager and the TS Reporting Adapter.  

Hadoop Hive Data Connection - Updated Support
The Hadoop environments supported by the TSS Hadoop Hive driver have 
been updated and include the following:

Table 9-1  Supported Hadoop Hive Environments

Environment Distribution Version Hadoop Hive Version

Amazon Elastic MapReduce 
(Amazon EMR)

N/A Hive 0.8.x
Hive 0.11.x

Apache Hadoop Hive N/A 0.8.x
0.9.x
0.10.x
0.11.x
0.12.x
0.13.x
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For more information, see the TSS Repository Administrator’s Guide.

TS Reporting Adapter
This section describes enhancements to the TS Reporting Adapter. 

New ODBC Query
There is a new query for use with the ODBC reporting adapter called view_
attribute_distinct_values. When used, it returns distinct values data for a 
specified attribute. 100 rows are retrieved unless the max_rows parameter is 
used.

Excel Sample Reports
Trillium Software offers a set of 10 customized Excel sample reports that show 
summary graphs and charts specific to your profiling and TS Quality data. The 
customized TSS Excel samples are now available for both OLE DB and ODBC 
Reporting Adapters (previously only OLE DB was supported). 

Switching Repositories in Excel
You no longer have to close and reopen Excel when you want to extract data 
from a different repository. 

Cloudera’s Distribution Including 
Apache Hadoop (CDH)

CDH4.0x
CDH4.1x
CDH4.2x
CDH4.5x
CDH5.0.x
CDH5.1.x

Hive 0.7.1
Hive 0.8.x
Hive 0.9.x
Hive 0.12.x

Hortonworks Distribution for 
Apache Hadoop

HDP 1.3 Hive 0.11.x

HDP 2.0 Hive 0.12.x

HDP 2.1 Hive 0.13.x

MapR Distribution for Apache 
Hadoop

MapR 1.2
MapR 2.0

Hive 0.7.1
Hive 0.9.x

Table 9-1  Supported Hadoop Hive Environments (Continued)

Environment Distribution Version Hadoop Hive Version
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Enterprise Integration Enhancements
This section describes enhancements and updates for the following TSS 
enterprise data products.

TS Director
The following changes are incorporated into this release:

 A new class, TrilliumDirectorSOAP, has been added to the IIS .Net Web 
Services API. TrilliumDirectorSOAP supports five new methods: 
•   CleanseUnicode()
•   ReferenceMatchUnicode()
•   WindowMatchUnicode()
•   DirectorSetup()
•   Ping()

This version of the .NET Web Services API requires IIS 7.x with 
ASP.NET using .Net v4.0. Windows Server 2012 is not supported.

 When creating or starting a Director, you can now specify whether the 
Director should route requests to servers based on the number of 
requests currently being handled by each server (Current Load) or 
rotate requests among servers (Round Robin). The default is Current 
Load.

TS Web Services
The following changes are incorporated into this release: 

 TS Web Services has been migrated to a Java implementation using the 
Apache Tomcat web server and the Apache Axis2 framework. (Previous 
versions used the Apache HTTP Server and Apache Axis2/C.) This 
change supports accurate processing of Unicode characters.

 The TS Web Service is now defined by one standard WSDL. A single 
class is used for cleansing, reference matching and window matching.
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CHAPTER 10

TSS v15.1 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.1 release including:

 User Interface Enhancements on page 78
 Data Quality Enhancements on page 80
 Repository Manager Enhancements on page 82
 Enterprise Integration Enhancements on page 83 

User Interface Enhancements
This section describes the enhancements and updates incorporated into the 
Control Center interface. 

Business Rules Manager
The Business Rules Manager is a new web-based application from which you 
can add, search, edit, and delete business rules (including rules in the Library), 
with a streamlined workflow to help you manage and organize business rules 
more efficiently. 

Features include:
 Support for editing multiple rules at a time.
 Available from the Control Center or as a stand-alone application.
 Advanced search using filters and conditions.
 Dynamic filtering of search results.
 Integration with Business Rules Library.
 Enhanced expression building capabilities (see Redesigned Expression 

Builder on page 79)
78 TSS v15 Release Notes



TSS v15.1 Enhancements
Opening the Business Rules Manager:
 In the Control Center, on the Advanced tab, click the Business Rule 

Manager icon.

 To open as a stand-alone application, users are sent an e-mail with a 
link. When users click the link, they are prompted to log in using either 
Windows- or Trillium-authentication (depending on the security 
configured in your environment).

Redesigned Expression Builder
When you work in the new Business Rule Manager, a redesigned Expression 
Builder is available to create and edit business rules. 

Features include:
 Expression validation, as you work or when you click Done to create the 

rule. The result of rule validation is displayed in a validation box. 
Validation allows you to make appropriate changes to the expression 
before saving it.

 Expression element panel. You navigate and select functions, operators, 
and other elements from an accordion-style navigation panel.

 Full text editor for writing and editing expressions. Includes the 
following functionality:
•   Search and replace expression characters and words
•   Go to a particular line in the text editor
•   Navigate various expression states by going back to a previous state 

or moving forward to the next state
•   Change font size
•   Wrap text 

 Ability to open multiple Expression Builders at the same time. For 
example, you can tile them side-by-side so that you can create/edit 
expressions for filtering, grouping, and aggregating at the same time. 

TO_INT64 Function
As of TSS 15.1, the function TO_INT64 has been removed from the Expression 
Builder. Use the function TO_INT which supports 32- and 64-bit data. 
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DAYMONTHYEAR Function
The date formats D-MON-YYYY and D-MON-YY are now supported. Other 
supported formats for DAYMONTHYEAR include:

 D/M/YY
 D/M/YYYY
 D-M-YY
 D-M-YYYY

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes.

TS Quality for Hadoop Projects
To support the TS Quality for Hadoop solution (see TS Quality for Hadoop on 
page 83), you can now create a TS Quality project (US or UK) designed to 
export to a Hadoop environment. 

Customer Data Parser
If the standard definition table (which contains all standard definitions used by 
the Customer Data Parser) is updated from a previous version of TSS, the 
differences between the old and new versions are documented in a new file 
called difftbl, located on the TSS repository server system (/tsq/tables/
parser_rules/difftbl). 

Use the file name to identify the versions compared. For example, AE-
difftsq15.0.0-to-tsq14r0.txt contains differences between TSS v14.0 and 
v15.0, AE-difftsq15.0.0_15.1.0.txt contains differences between v15.0 
and v15.1.

Geocoder
When specifying Geocoder options, there is a new Timeout (seconds) option. 
This allows you to enter a numeric value for the maximum amount of time in 
seconds that the Geocoder is allowed to take. The default timeout is 5 
seconds.

Do not change the default value unless requested to do so by Trillium 
Software's Customer Support or Professional Services department. 
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Postal Matchers

Asian Countries Postal Matcher
There are four new output flag attributes for the Asian Postal Matcher 
countries (China, Japan, Korea, and Taiwan), described in Table 10-1:

For more information in the TSS Help, see Reference Material > Postal Matcher 
Attributes and Results for Asian Countries > Postal Matcher Attributes for 
Asian Countries (China, Japan, Korea, Taiwan).

Global Postal Matcher
 Extended ACR Code. In previous versions of TSS, standard was the 

single available level of Address Correction Result (ACR) code in the 
Global Postal Matcher. In this release, a second level, extended, has 
been added. The extended ACR details the status of all address 
component attributes, whereas the standard ACR details the status of a 
subset of address component attributes. The extended ACR is stored in 
the new attribute called ga_gout_ext_acr. 

For more information in the TSS Help, see Develop > Postal Matchers > 
Global Postal Matcher > Address Correction Result (ACR) Codes.

 New Options:
•   Enforce Blanks. There is a new advanced option called Enforce 

blanks. When selected, this option clears populated address 
attributes if the postal table specifies that it should be blank for the 
matched address.

•   Timeout (seconds). See Geocoder on page 80. 

Table 10-1  Asian Country Postal Matcher Output Attributes

Attribute Length Description

pr_level1_level2_
changed

1 Change flag. Values are:
 Y—There are changes in level 1 or level 2. 
 Blank—No change or no match to directory. 

pr_level3_level4_
changed

1 Change flag. Values are:
 Y—There are changes in level 3 or level 4. 
 Blank—No change or no match to directory.

pr_postcode_changed 1 Change flag. Values are:
 Y—There are changes in postcode.
 Blank—No change or no match to directory.

pr_validate_with_
correction

1 Validation flag. Values are: 
 Y—Fail Level (pr_geocode_fail) is 0 and any of 

the change flags are set to Y. 
 N—Fail Level (pr_geocode_fail) is 0 and all of the 

change flags are set to blank.
 Blank—Fail Level (pr_geocode_fail) is not 0 (no 

match to directory).
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Great Britain (GB) Postal Matcher
There is a new option called Perform additional matching. When checked, 
the additional match will be attempted using the postcode and the street 
name. This option is useful when you assume the input postcode is correct but 
the other components are incomplete to make a match by the standard match 
process. 

For more information in the TSS Help, see Develop > Postal Matchers > United 
Kingdom (GB) Postal Matcher > Specifying GB Postal Matcher Options.

Transformer Data Reconstruction - Derived Attributes
There are two new derived attributes for use with Transformer Data 
Reconstruction called dr_address_2 and dr_project_code. dr_project_code 
contains a two-character country code of the country template. The attribute is 
useful to flag and group the ZZ (basic) countries later in the project flow and 
to identify the project flow when you route a country to another country. 

For more information in the TSS Help, see Develop > Transformer > Special 
Transformers > Transformer Data Reconstruction > About Derived Attributes.

Repository Manager Enhancements
This section describes enhancements to the Repository Manager. For more 
information, see the TSS Repository Administrator’s Guide.

Activating the Business Rules Manager
In the Repository Manager, in the Options window, there is a new Manager 
Environment option called Enable Business Rule Manager (selected by 
default). When selected, all TSS users logged into the Control Center have 
access to the new Business Rule Manager. 

When deselected, the icon to open the Business Rule Manager does not display 
in the Control Center. For more information, see Business Rules Manager on 
page 78.

TSS ODBC Loader Connection - Impala Support
You can now load data into the TSS repository using the TSS Impala Wire 
Protocol ODBC driver. Supports Cloudera Impala 1.0 database server.

New Setting for config.txt File
When you work with entity business rules that use the advanced Group By 
option, and you run analysis jobs on multiple rules at a time you may 
experience performance issues including a slow down (or hanging) of your 
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system. 

business_group_limit is a new optional setting in the TSS server config.txt 
file that allows you to limit the number concurrently run analysis jobs that 
include Group By business rules. Setting a limit can help avoid overworking 
shared resources on your system. 

business_group_limit is used in conjunction with the 
maximumWeight setting, which needs to be set to a value greater 
than 1 to allow multiple jobs to be run concurrently. 

Enterprise Integration Enhancements
This section describes enhancements and updates for the following TSS 
enterprise data products.

TS Quality for Hadoop
With the introduction of TS Quality for Hadoop, TS Quality US and GB batch 
projects can now be run in a Hadoop environment, using native Java 
MapReduce across Hadoop Distributed File System (HDFS) data clusters. 

This release includes the following features:
 Trillium projects are deployed using the new Trillium Batch to Hadoop 

Cluster Deployment Manager. The Deployment Manager configures the 
project and deploys it to a Linux gateway server, from which you copy it 
to HDFS.

 The solution uses native Java MapReduce programs.
 Using a new architectural paradigm—Trillium Server Interface (TSI)— 

data is processed in parallel across the Hadoop cluster through Java API 
calls to 64-bit TSS core modules, using Hadoop's MapReduce 
infrastructure. 

 Window Matching and Reference Matching are supported.
 The Global Data Router is supported, allowing multiple country projects 

(US and UK only). 
 Commonization and Survivorship are supported.
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CHAPTER 11

TSS v15.2 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.2 release including:

 EDQ 64-Bit Enabled TSQ Data Processing on page 84
 Business Rules Center on page 89
 Data Quality Enhancements on page 90
 Enterprise Integration Enhancements on page 91 

EDQ 64-Bit Enabled TSQ Data Processing
With TSS Version 15.2, Trillium Software expands support of 64-bit processing 
on Windows and Linux operating systems with the availability of Trillium 
Software Enterprise Data Quality (EDQ), the 64-bit enabled implementation of 
TS Quality. 
Depending on your product key, your EDQ installation options may include:

 Enterprise Data Quality, which installs the 64-bit enabled core TS 
Quality modules and Trillium tables. TS Quality batch and real-time 
projects can be executed (run) on 64-bit platforms using full 64-bit 
processing.

 TS Quality for Hadoop, which installs the Hadoop connector, enabling TS 
Quality processing across a Hadoop cluster. Enhanced country support 
and deployment enables you to manage the TSS software, projects, and 
postal file distribution more efficiently across the HDFS cluster.

 TS Quality for Real Time, which installs the TS Director, a service that 
provides transaction load balancing and server connection management 
for client applications. There are two optional components available 
with the TS Quality for Real Time installation:
•   TS Web Services - TS Web Services enables Trillium processing 

through industry-standard SOAP requests. Selecting this option 
installs the Apache Tomcat Web Server. Java version 1.7 is required.
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•   Director SDK - The Software Development Kit includes the Java API, 
code samples, and a sample project, director_proj. You can 
optionally install cleansing and matching services to test your client 
application. 

 TS Quality for SAP, which installs the SAP connector, enabling TS 
Quality integration with the SAP NetWeaver RFC client in support of 64-
bit.

Note the following:
 Control Center and the TSS repository remain 32-bit applications. All 

processes run in the Control Center are 32-bit; when you export TS 
Quality projects, batch scripts for both 32-bit and 64-bit processing are 
created. The 64-bit batch script runs using the 64-bit encoded TSQ core 
modules.

 New 8-bit Unicode Transformation Format (UTF-8) postal tables are 
available for the 16 Postal Matcher and Custom Postal Matcher countries 
and are required for EDQ processing. See UTF-8 Postal Tables on 
page 87.

 If you upgrade to v15.2 from a previous version of v15, and you choose 
to install and use the 64-bit components, you must also install the 32-
bit product components. This allows for testing your existing TS Quality 
projects concurrently on the same TSS server system with the 
redeployed version to verify that the results are as expected for each 
project. It is recommended you do this before you deploy to a 64-bit 
production environment.

 There is no batch script for parsing customization in 64-bit. Run the 
parsing customization in the Control Center for 64-bit projects before 
deploying.

 The Batch Deployment Tool (BDT) command line scripts cannot be used 
to create the scripts for 64-bit batch deployment.

 Siebel Connector is not supported with EDQ, but is available as a 32-bit 
component. 

 The following are not supported with EDQ 64-bit: Trillium Monitor, 
HTTP-over-HTML servers, J2EE and IIS .NET (legacy web services), and 
C++ APIs.

 In 64-bit, the TS_QUALITY environment variable is not needed. 
However, existing 32-bit functions remain unchanged and continue to 
use the TS_QUALITY environment variable.

Running 64-bit TS Quality Projects
New and existing TS Quality projects can be deployed to and executed using 
64-bit processing. Note the following guidelines for working with projects 
intended for 64-bit execution:

 For existing batch projects created in an earlier version (pre-v15.2) of 
TSS, to take advantage of 64-bit functionality, you must re-export the 
project to batch to generate the 64-bit script.
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 While the new UTF-8 tables are used when you run your batch script on 
64-bit systems, you still need to use the 32-bit postal tables when 
creating and working with your project in the 32-bit Control Center. 

 After you export a batch project, ensure you are pointing to the relevant 
64-bit directories and have set the TS_QUALITY_64 environment 
variable to the version number folder of the 64-bit Quality installation. 
For information, see the TSS Help (Deploy > Exporting a Project to a 
Batch Script and Running a Batch Project). 

Batch Scripts
You can export a project into a batch script which can be run on either a UNIX 
or Windows platform outside of the Control Center. When you export a project 
to batch, a total of three scripts (two 32-bit and one 64-bit) are generated. 
Select and run the appropriate script depending on your system environment.

As of Version 15.2, a batch export to a 64-bit environment is 
supported for Windows and Linux only.

 Batch scripts for UNIX:
•   runprojectN.sh - runs the batch project in 32-bit
•   customize_len/ben.sh - runs parsing customizations in 32-bit
•   runprojectN_64.sh - runs the batch project in 64-bit (Linux only)

Where N is the number of your project.

 Batch scripts for Windows:
•   runprojectN.cmd - runs the batch project in 32-bit
•   customize_len.cmd - runs parsing customizations in 32-bit
•   runprojectN_64.cmd - runs the batch project in 64-bit

There is no batch script for parsing customization in 64-bit. The 
parsing customization must be run in the Control Center for a 64-bit 
batch project.

Guidelines for 64-bit Batch Processing
Note the following when you export a project into a batch script intended for a 
64-bit processing environment:

 For the Postal Matchers, the new UTF-8 postal tables are required to run 
a batch script in 64-bit. For more information, see UTF-8 Postal Tables 
on page 87.

Previously only 32-bit versions of these postal tables were available for 
use with TS Quality. Continue to use the 32-bit supported tables for TS 
Quality project testing in the Control Center and to export batch scripts 
to 32-bit systems. 
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 A configuration file (Config64.tbl) will be automatically created in the 
project’s settings folder when you run the 64-bit script for the first time. 
This file will be used by the 64-bit batch execution scripts. 

 The following TS Quality processes are not supported when using 64-
bit:
•   Database Read/Write process
•   Certified Postal Matchers (Australian AMAS certification, Canadian 

SERP program, and United States CASS Postal Matcher)
•   Profiling processes (Analysis, Business Rules, Dependencies, Keys, 

and Load)

Running 64-Bit and 32-Bit Concurrently
You can install TS Quality (32-bit) and EDQ (64-bit) on the same machine for 
testing purposes. Components are segregated in different directory paths and 
do not conflict. The version that will be used to process your data depends on 
your project selections.

 Batch scripts - When you export a project to a batch script, TS Quality 
creates different versions of the script. Run the 32-bit version to use the 
32-bit TS Quality core components; run the 64-bit version to use the TS 
Quality 64-bit core components. (See Batch Scripts on page 86.) 

 Real-time projects - When you create a cleanser or matcher, you select 
the processing type, which determines whether the project will run with 
32-bit or 64-bit components. 

You can test your data using both 32-bit and 64-bit execution before moving 
your projects into a 64-bit production environment. 
When switching between 32-bit and 64-bit projects, you must make two 
changes to your environment:

 If both 32-bit and 64-bit locations are included in your PATH 
environment variable, the first location in the path list will be used. You 
can find the currently defined location by using the 'which' command on 
Linux to search for libtrilTGenClientLibrary.so, or the 'where' 
command on Windows to search for TGenClient.dll. Change the PATH 
environment variable to point to the correct library location. 

 Change the JRE_HOME location. 32-bit projects must use the JRE 
included with the 32-bit Trillium installation; 64-bit projects use the JRE 
included with your Java installation.

UTF-8 Postal Tables
8-bit Unicode Transformation Format (UTF-8) is a variable-length character 
encoding for Unicode. UTF-8 can represent every character in the Unicode 
character set and is compatible with ASCII. 

EDQ 64-bit processing supports postal tables in UTF-8/Unicode format only. 
Therefore, for the Postal Matchers, the new UTF-8 postal tables are required to 
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run a batch script in 64-bit for the following 16 countries: Australia, Belgium, 
Canada, France, Germany, Great Britain, Hong Kong, Italy, Luxembourg, 
Malaysia, Netherlands, Portugal, Singapore, Spain, Switzerland, and United 
States. 

The Control Center still needs the 32-bit version of the postal tables 
to process data before you export to batch. 

UTF-8 Benefits
UTF-8 removes certain global data processing limitations. For example, using 
the UTF-8 character format, the Postal Matchers can now properly handle 
special characters not available through single-byte code pages (tables of 
values that describe the character set used for encoding). The results from 
Parsing and Matching processes may show differences when comparing the 
results of the same data using the 32-bit tables. The UTF-8 data results will 
include special or outlier characters (that is, characters that fall outside of the 
256 character limit) that other encodings cannot read or do not pass. 

The changes apply mainly to non-ASCII data. 

For information about installing and configuring your system to use these 
tables, see either the Postal Directory Installation Guide or, in the TSS 
Installation Guide, the Installing Postal Directories chapter. 

About EDQ Table Locations
To process your data, TS Quality projects use several tables, such as postal 
tables, parser rule tables, code page tables, and so on. The location of your 
EDQ tables is defined in an initialization file, EDQ.ini. By default, EDQ.ini 
identifies the path to your tables as /install_path/tables (Linux) or 
\install_path\Trillium Software\EDQ\15\tables (Windows).

The tables directory is created by the EDQ installation and contains the 
following subdirectories:

 ACE_tables. Tables for the JP Postal Matcher Address Code Edition 
(ACE) Postal Matcher.

 aptables. Tables for the Postal Matcher for China, Japan, Korea, and 
Taiwan. 

 census_tables. Tables for US Census Geocoder used with the US Postal 
Matcher.

 code_pages. Code page tables. 
 gatables. Tables for countries used by the Global Postal Matcher. 
 general_resources. General process files, including rule, table, ddx, ddl, 

and map files. 
 parser_rules. Parser rules file. 
 postal_utf8. Tables for 64-bit UTF-8 postal.

For the 16 countries that have both the 32-bit postal tables and 64-
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bit UTF-8 postal tables, these tables cannot reside in the same 
directory. Tables for other countries (APAC, global postal matcher, 
and so on) can reside in the same directory.

For the 16 Postal Matcher countries (including those for the Custom Postal 
Matcher) there are two versions of the postal tables—one for 32-bit TS Quality 
processes, and the UTF-8 version to support EDQ 64-bit. 

However, all other countries (APAC, global postal matcher, and so on) need 
only one instance of the ACE_tables, aptables, census_tables, and gatables 
postal tables as they are already compliant with UTF-8 and/or Unicode data. 
Therefore, you can simplify project configuration and set EDQ.ini to point to a 
single set of tables used for both EDQ 64-bit processing and 32-bit processing.

For more information about installing the EDQ components and the EDQ, see 
the TSS Installation Guide or the Postal Directory Installation Guide. 

Business Rules Center
The Business Rules Center (formerly the Business Rules Manager) is a web-
based application from which you can add, search, run, edit, and delete 
business rules (including rules in the Library), with a streamlined workflow to 
help you manage and organize business rules more efficiently. 

New features include:
 Ability to run business rule analysis on one or multiple rules at a time. 
 You can now export and import business rule sets, rule search results, 

and rule analysis results.
 Options to Copy and Save As business rules to create similar rules.
 Business rule search now includes case insensitive search feature.
 Customize views of search results and metadata by sorting, filtering, 

and locking columns. 
 New Task Manager allows you to view the progress tasks, such as 

business rule analysis, that are run in the background. 
 When accessed from the Control Center, the Business Rules Center 

opens in a separate browser window rather than a tab in the Control 
Center. 
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Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes.

Postal Matchers

Certified Postal Matchers
The following certified Postal Matchers and not supported for EDQ (64-bit), 
although they remain valid for TSS 32-bit processing:

 Australia (AU) – AMAS Australia Post
 Canada (CA) – SERP Canada Post Corporation
 United States (US) – CASS United States Postal Matcher

Korean Postal Matcher - New Postal Code System
Effective on August 1, 2015, South Korea’s existing 6-digit postal codes were 
replaced with a new set of 5-digit postal codes. As a result, the new postal 
directories will change to the new format and will convert the 6-digit postal 
codes to the 5-digit postal codes.    

After you install or upgrade to TSS v15.2, you can use either the new postal 
directories for Korea or the older, pre-15.2 (32-bit) directories, but not both 
versions. If you install EDQ, you can only use the new table. The older table is 
not valid for 64-bit processing. 

For more information in the TSS Help, see Develop > Postal Matchers > Postal 
Matcher for Korea (KR) > New Postal Code System for Korea.

Relationship Linker Results Analyzer
This new application allows you to browse the results of your linking process 
and examine the relationships between the matched data. After you have run 
the Relationship Linker, you can open the Relationship Linker Results Analyzer 
and display match results.

It is important to examine your matched results to see how records were 
initially matched. You can then decide if it is necessary to adjust the linking 
rules according to your business requirements.

UTF-8 Multiplication Rule
The UTF-8 multiplication rule applies generally only to delimited files, not 
fixed-length files. You can now manually enable the UTF-8 rule for all types of 
files and projects. 

For more information in the TSS Help, see Reference Material > Encoding and 
Types > Working with UTF8 Data. 
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Enterprise Integration Enhancements
This section describes enhancements, updates, and changes for TSS 
enterprise data products. 

TS Connector for Siebel
The Siebel Connector is not available for use with EDQ core components. For 
Siebel Connector support, install the ECS software. 

TS Director
A new version of TS Director is available for use with EDQ components when 
you install TS Quality for Real Time. For more information, see EDQ 64-Bit 
Enabled TSQ Data Processing on page 84. 

TS Quality for Hadoop
The TS Quality for Hadoop solution includes enhancements to country support 
and deployment:

 TS Quality for Hadoop now includes a script that copies all Trillium 
components to all nodes in your Hadoop cluster.

 TS Quality for Hadoop now offers full global country support, including 
country projects, postal directories (where available), double-byte 
countries, and also those countries supported by the Global Postal 
Matcher. 

TS Web Services
The following changes and additions are incorporated into this release:

 TS Web Services support is now available on both 32-bit and 64-bit 
platforms. 

 TS Web Services using Trillium Server Interface (TSI) is the 64-bit 
enabled implementation of TS Web Services. TSI, part of Trillium's 
Enterprise Data Quality (EDQ) technology, provides the underlying 
technology for communication with TSS components. TSI enables 
secure data transfer through use of security certificates on the Apache 
Tomcat web server. Optional user authentication provides additional 
security. 

Using TSI, cleansing and matching processing is performed entirely in 
memory, enhancing performance. TS Web Services using TSI is 
supported on Windows and Linux 64-bit systems.

 A new user interface, SOAP Service Administration, allows you to 
configure your projects, starting your projects, viewing a log of TSI 
activity, and to optionally add web access keys to require user 
authentication for access to TS Web Services. This version supports 
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setting match levels one through four for both consumer and business 
matches.

SAP
The following changes for SAP are incorporated into this release:

TS Quality for SAP (SAP Connector)
 The new 64-bit SAP Netweaver RFC library product is available with 

EDQ, and is supported on Windows and Linux systems. For information 
about changes to support the new RFC library, see Function Module 
Name Changes.

 Starting with TSS v15.2, TSS will no longer deliver software for the 32-
bit version of the SAP Connector ahead of SAP’s decision to discontinue 
support of the 32-bit SAP RFC library product as of March, 2016. SAP 
will now be available for 64-bit only. If you need to run SAP with the 32-
bit SAP RFC library product, it is recommended that you continue to use 
an earlier release of TSS.

 EDQ Installation Note: For the TS Quality for SAP, and for any client 
using TS Director, after installation you must set the following 
environment variables:
•   TRILLDIRADDR: Name of the host or IP address (in dotted decimal 

format) of the node on which the Director listens. Set on client and 
cleansing/matching service machines.

•   TRILLDIRPORT: Port on which the Director listens for incoming 
requests. Set on client and cleansing/matching service machines.

Function Module Name Changes

To accommodate the 64-bit SAP Netweaver RFC library, the RFC function 
module names have been moved into the /TRILLIUM/ namespace. This is 
required of all RFC function module names because the RFC server functions 
are now defined inside the SAP data dictionary. For example, for the SAP 
Cleanser, the function module names are now /TRILLIUM/DO_CLEANSING and 
/TRILLIUM/GENERATE_WINDOW_KEYS.

Upgrade Recommendations. If you are upgrading to TSS v15.2, and you 
have developed custom applications that call Trillium, you may need to change 
your customized code after you upgrade, depending on how you have 
implemented the Trillium calls. 

If you do not use custom applications to call Trillium, during the 
upgrade the customizing settings are automatically updated. 

BADI Methods. It is recommended that, if possible, your custom applications 
call the following BADI implementation methods instead of calling the RFC 
functions directly because the BADI methods automatically read the 
customizing settings and dynamically call the Trillium RFC functions:

 For address cleansing, use the BADI ADDRESS_CHECK method IF_EX_
ADDRESS_CHECK~ADDRESS_POSTAL_CHECK.
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 For duplicate checking, use the BADI ADDRESS_SEARCH method IF_
EX_ADDRESS_SEARCH~ADDRESS_SEARCH.

Trillium RFC Function Methods. If the full BADI implementation methods 
cannot be used (for example, for objects that do not use Business Address 
Services addresses), then consider reading the customizing settings and 
dynamically calling the Trillium RFC functions using the following lower-level 
methods:

 For address cleansing, use /TRILLIUM/CL_IM_ADDR_CHECK=> DO_
CLEANSING. This method reads the configuration and calls the RFC 
function.
•   For duplicate checking, use method /TRILLIUM/CL_IM_ADDRSEARCH 

=>GET_MATCHER_PARAMETERS to read the configuration and 
/TRILLIUM/CL_IM_ADDRSEARCH=>DO_MATCHING to call the RFC 
function for matching. Both calls are required. 

SAP MDG
TSS v15.2 includes support for SAP Master Data Governance (MDG) 7.0, 
including cleansing, matching (de-duplication), and fuzzy search of world-wide 
name and address information for Customers (organizations), Suppliers 
(organizations), and business Partners (organizations and individuals). A user 
interface for user acceptance, available in English and German, is included. 
SAP MDG 7.0 is implemented on an SAP ERP system, which requires SAP ERP 
6.0 Ehp7.

This release is available on Windows x86 64-bit and Linux x86 64-bit 
platforms.
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CHAPTER 12

TSS v15.2 Update 1 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.2 Update 1 release including:

 TS Web Services on page 94

TSS v15.2 Update 1 is a 64-bit update only, valid for Enterprise Data Quality 
(EDQ) functionality on Windows and Linux systems. For more information 
about EDQ, see EDQ 64-Bit Enabled TSQ Data Processing on page 84. 

TS Web Services
Version 15.2 Update 1 of TS Web Services SOAP Service Administration 
introduces the following features:

 Two new tabs have been added to the Administration Home page:
•   The new Environment tab assists with troubleshooting. It displays 

settings such as your system path, operating system version, and 
whether or not the TSI Dynamic Library is loaded. If your 
environment is not correctly configured, a message displays alerting 
you to the problem.

•   The new Settings tab allows you to set the SOAP Service logging 
level and to specify whether the current project should automatically 
start when Tomcat starts.

 A new tab, Project Log, has been added to the Project Configuration 
page. It allows you to view the log file for the currently running project.

 The ability to set a cleanse limit has been added to the Add Web Access 
Key page. This option is used by system administrators when setting up 
a TS Web Services evaluation configuration. It sets a threshold for 
cleanse requests which, when reached, disables access to the cleanse 
service.

 A new page, Cleanse Count by Country, has been added. Using this 
page you can monitor the number of cleanse requests being generated 
for each of your licensed postal matcher countries. This feature provides 
insight into the distribution of your organization's data quality activity.
94 TSS v15 Release Notes



TSS v15.2 Update 1 Enhancements
 TS Web Services now supports JRE 1.8. 

Master Batch processing is a new enhancement added to TS Web 
Services. Master Batch is used by Trillium staff during initial 
implementation of certain Trillium solutions, such as Trillium for 
Microsoft Dynamics CRM.
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CHAPTER 13

TSS v15.2 Update 2 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.2 Update 2 release including:

 Data Quality Enhancements on page 96
 Enterprise Integration Enhancements on page 98

TSS v15.2 Update 2 is valid for TSS 32-bit for Windows and UNIX platforms 
(Linux, HP-UX, AIX, and Sun), and EDQ 64-bit processing for Windows and 
Linux platforms.

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes. 

Basic Country Project
A new mask file called zzmasks.win/unx is now included to manage all alphas 
and numerics in the Basic Country (ZZ) project. 

Bulgaria Cyrillic
This release of TSS includes Bulgaria Cyrillic-native language support. 

Bulgaria Cyrillic Data Process. You can now select Bulgaria (Latin-1) or 
Bulgaria (Cyrillic-native) in the Control Center when creating a project. You 
can also browse the data in the Postal Browser. 
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Ireland Ericode
Effective in July 2015, Ireland has started a new postal code system, Eircode. 
An Eircode is a unique code designed to accurately identify the location of an 
address, and is assigned to each residential and business address. Existing 
postal addresses have been assigned Eircodes.

Note the following guidelines when using Eircode for Ireland in TSS:
 You can use Eircode for input data for TSS processing. However, TSS 

cannot validate Eircode as our current postal tables for Ireland do not 
include Eircode information. 

 Directory Browser does not display Eircode. 
 Even though a record receives a Match Level Code of ‘0’ (exact match to 

postal table), this does not mean the Eircode is validated. 
 If Eircode is present in the input data, it will be returned in GA_GOUT_

POSTAL_CODE. 
 If the Dublin city code is present in the input data, it will be returned in 

GA_GOUT_EXTRA_CITY and in GA_GOUT_POSTAL_CITY.

Global Data Router
The Country Rules Table (rtrules2.win/unx) now supports UTF-8 encoding, so 
you can define rules for country names and cities in native languages. Prior to 
this, encoding was limited to Latin-1. 

Transformer - Web Service Map Files Changes 
The Transformer allows you to call XML-based, third-party web services in the 
Control Center by utilizing a map file. Map files contain all the information 
required to define a specific web service call and its corresponding response.

As of TSS v15.2 Update 2, the following changes apply:
 Previously, the Transformer supported encrypted map files only. Now 

encrypted map files can be used. The Transformer will automatically 
check to see if a map file is encrypted. If it is, it will be decrypted.

 You can now supply your own map files/tables, although they must be 
customized by Trillium Software Consulting. Contact Trillium Technical 
Support or your Trillium Account Representative for more information. 
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Enterprise Integration Enhancements

TS Web Service Manager
The following enhancements have been added to the Web Service Manager:

 Testing of both 32-bit and 64-bit TS Web Services implementations is 
now supported. 

 Creating test requests has been simplified with the addition of an input 
grid to enter test data.

 Results of a test request can now be viewed as name/value pairs.
 On the Matcher Input/Output Fields tab, the Selected Fields list is now 

automatically populated with the contents of the Match Fields List. 
 For the 32-bit implementation, a new button on the Server 

Configuration tab, Get Director Setup, displays the values of 
TRILLDIRADDR and TRILLDIRPORT from Apache Tomcat. This button is 
inactive for 64-bit (TSI) implementations; TSI does not use these 
variables.

SAP Add-On Support Package 01 for Add-On v8.5
This support package corrects issues with handling of parallel processing in the 
/TRILLIUM/RSADRINI program.
98 TSS v15 Release Notes



TSS v15.3 Enhancements
CHAPTER 14

TSS v15.3 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.3 release including:

 Discovery Center on page 99
 Transformer Web Services Map Files Changes on page 100
 Postal Table Shipment Changes on page 100
 Trillium for SAP on page 101

Discovery Center
The Discovery Center (formerly the Business Rules Center) is a web-based 
application from which you add and manage business rules (including rules in 
the Library) and data sources (entities) using a streamlined workflow. 

New features include:
 Task Queue. Always available from anywhere in the Discovery Center, 

the Task Queue allows you to quickly track the status of jobs that are 
running or waiting to run. 

 Add Data Source. Add a new data source (entity) to your repository. 
Drill down to see your data rows, metadata, attributes, and associated 
business rules. Associate a library rule set to a data source, creating a 
connection to the data source attributes. Export data source metadata 
views as .csv files.

 Charts and graphs. Data visualization using bar and pie charts and 
graphs has been added to give at-a-glance overviews of the status of 
your data quality results. Quickly view the structure and content of your 
original data rows. Enhanced visualizations help you understand and 
drill into passing and failing records, grouped or aggregated rule 
results, and data source, business rule, and attribute metadata. 

 Enhanced Metadata Review. Review and act on relationship analysis 
including keys, dependencies, dependency conflicts, and joins. 
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 Navigation and Drill-downs. Toggle to important information while you 
work. Additional drill-downs and navigation is available to access your 
metadata, and business rule, attribute, and entity analysis results.

 Associations. Assess impact of changes to library rules by viewing and 
modifying rule associations to data sources. 

 Exports. Export rules, rule results, attributes, data rows, and data 
sources to share rules and information across repositories and 
environments.

 Contextual online help. 

Discovery Center supports Internet Explorer 10 and 11. If you are 
using Windows 10, you must access the Discovery Center with IE 11 
because Microsoft Edge is not supported. 

Transformer Web Services Map Files Changes 
The Transformer allows you to call XML return-based, third-party web services 
in the all TSQ workflows by utilizing a map file. Previously, the Transformer 
supported encrypted map files only. Now unencrypted map files can be used. 
Encrypted map files are still supported in v15.3. 

The Transformer now only supports web-service map files customized by 
Trillium Software Consulting. Contact Trillium Technical Support or your 
Trillium Account Representative for more information.

Postal Table Shipment Changes
As of July 1, 2016, Trillium Software will no longer provide CD deliveries for 
updates to our postal directories or updates to our United States centroid 
latitude/longitude directories. All updates will be provided on our secured FTP 
site. 

All Trillium Software customers have an account on this site. If you are unsure 
of your credentials, please contact Trillium Customer Support. If you have any 
questions, please contact your Trillium Customer Success Manager or Trillium 
Customer Support.
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Trillium for SAP
The following are Trillium for SAP enhancements:

MDG 8.0 Support
TSS v15.3 includes support for SAP Master Data Governance (MDG) 8.0 and 
includes the following enhancements:

 The Score returned in the Duplicate Check result list has been enhanced 
to return a more comprehensive match score.

 The Duplicate Check Popup has been enhanced to include First Name 
and Last Name fields of the BP person.

SAP HANA Certification
TSS has achieved SAP-certified integration with SAP NetWeaver running on 
SAP HANA®. 

When you migrate your SAP NetWeaver systems to SAP HANA, your 
integration with TSS will continue to work seamlessly. This certified integration 
also allows you to implement SAP ERP®, SAP CRM®, SAP MDG®, and other 
applications running on SAP HANA to integrate with TSS.
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CHAPTER 15

TSS v15.4 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.4 release including:

 Discovery Center on page 102
 Quality Transformer on page 103
 Enterprise Integration on page 104

For important changes to the v15.4 installation and supported platforms, see 
TSS Important Changes on page 12.

Discovery Center
The Trillium Discovery Center is a web-based application from which you view, 
manage, and analyze objects in your TSS repository including business rules, 
data sources (entities), attributes, data rows, library rule sets, join analyses, 
and all associated metadata. 

New features include:
 Join Analyses. You can now generate join analyses across and within 

data sources against the intersection of one or more sets of attributes. 
 Browser Support. In addition to Internet Explorer 10 and 11, the 

Discovery Center now supports Google Chrome.
 Export Relationships. You can now export join metadata and join 

analyses results, as well as key and dependency metadata, as a .csv 
file. 

 Change Relationship Status. After you review relationship analysis, you 
can change the permanent or discovered status of a key, join, and 
dependency depending on validity of the analysis. 

 Data Sources. The following data source functionality has been added 
for v15.4:
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•   Add New Attribute/Column. When adding a data source to the 
repository, you can add a new, customized attribute (column) to the 
data source. 

•   Upload File from Local System. You can add a data source by directly 
loading a delimited data file from your local system.

•   Add Rule Set Associations to Data Sources. When examining a single 
data source, you can associate the data source to a rule set without 
having to navigate to the Library. 

•   Add Rule to Data Source. You can add a new rule directly to a data 
source. 

•   Delete Data Sources. You can delete one or more data sources from 
a repository.

 Mask and Value Recodes. You can recode masks and data values. A 
recode is a user-defined revision, or recoding, of a mask shape or data 
value. You then export the recoded masks or values in a table for use in 
Transformer projects.

 Uploading Files to the Server. You can upload a file from your local 
system to the TSS repository server for use in the Discovery Center.

Quality Transformer
This section describes the enhancements and changes incorporated into the TS 
Quality Transformer process.

Trillium Precise Web Services
Trillium Precise is a new, optional JSON-based web service available for use 
with the Transformer and allows you to validate business and personal e-mail 
addresses and phone numbers. Validation includes checking that the e-mail 
address or phone number is valid, whether the registered name matches the 
input name, validating the country code with which it is associated, and other 
validation information. Data can be validated during a batch process or in real 
time as records are entered. 

Trillium Precise is an optional component licensed separately. E-mail 
and phone validation is supported for most of the countries including 
the U.S. and Canada. Coverage varies by country. 

Trillium Precise uses map files included in your TS Quality installation. When 
you license Trillium Precise, you configure the Transformer to send a name, 
address, e-mail address, IP address, and/or phone number to the Trillium web 
server to request validation. When the Transformer is run, the validation 
results are returned to the Transformer output. 

For the Transformer to call the Trillium Precise web services, you must specify 
the map files and define the input and output attributes in the Output 
Transformation setting. The map files contain all the information required to 
define a Trillium Precise web service call and its corresponding response.
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Note for Blank Map Values
When mapping attributes for input, if you are using the User Credentials 
section to enter your user key, you must keep the Use blank map value 
option unselected for the first attribute (TSPx_IN_KEY). 

However, if there are any other attributes that you do not map in, you must 
select the Use blank map value options for those attributes. 

To see more information about Trillium Precise in the TSS Help, see Develop > 
Trillium Precise Web Services. 

Legacy Plus (+) Operator
When specifying output data in the Transformer, there is a new option called 
Use Legacy Plus Operator. When selected, the plus operator (+) in your 
expression statements concatenate multiple arguments (strings, attributes, 
and integers) with no space between arguments. 

This option is to be used only for backwards compatibility with TS Quality 
projects created in pre-15 versions of TSS.

Enterprise Integration
This section describes enhancements and updates for the following TSS 
enterprise data products.

Trillium for Siebel
Trillium for Siebel now supports Siebel 2016. This is in addition to support of 
Siebel 8.1.1.14 CRM and UCM. 

TS Director (32-Bit) Web Services
The following are no longer supported:

 The Director J2EE Application Programming Interfaces (APIs).
 Deployment using Oracle® WebLogic® and IBM® WebSphere®. 
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CHAPTER 16

TSS v15.5 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.5 release including:

 Discovery Center on page 105
 United States (US) Postal Matcher on page 106

For important changes to the installation and supported platforms, see TSS 
Important Changes on page 12.

Discovery Center
The Trillium Discovery Center is a web-based application from which you view, 
manage, and analyze objects in your TSS repository including business rules, 
data sources (entities), attributes, data rows, library rule sets, relationship 
analyses, and all associated metadata. 

New features include:
 Browser Support. In addition to Internet Explorer 10 and 11 and Google 

Chrome, the Discovery Center now supports Microsoft Edge.
 Add New Attribute/Column. You can add a new, customized attribute 

(column) to most tab views. 
 Add Keys and Dependencies. You can now create and discover keys and 

dependencies. 
 Manage Business Rule Priorities. You can now add, edit, and delete 

business rule priorities. 
 Edit Attributes. You can edit the name and description of data source 

attributes. 
 Refresh. Use the new refresh button on the Menu bar to refresh the data 

displayed on the current page.
 COBOL Data Sources. You can now add a data source using a COBOL 

copybook data source. 
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United States (US) Postal Matcher
Beginning in Version 15.5, Delivery Point Validation (DPV), Locatable Address 
Conversion System (LACSLink), SuiteLink, and Residential Delivery Indicator 
(RDI) products of the United States (US) Postal Matcher became compliant 
with the new USPS encryption standard. As a result, the following features 
have been added or changed: 

 New USPS product directories. The new set of USPS product directories 
are available to download and install.

 Hash table for DPV. The US DPV processing no longer uses the 
segmented 100 DPV hash tables (dph.hsa.z00-z99); it uses only one 
hash table (dph.hsa).

 Reporting false positive records. There is a new process to report a 
False Positive File to Trillium Software Customer Support if you 
encounter an error message. The False Positive File includes any false 
positive records along with your company's name and address 
information. You must specify this information in the Control Center 
before processing. 

 Fields Not Returned for Callable Processing. Certain fields are no longer 
returned when running the US Postal Matcher in callable mode (API), 
due to license agreement with the USPS.

If you have an existing project created in TSS v15.4 or earlier with these USPS 
products invoked, you will need to update the product directories. In addition, 
you will need to update the project for the new settings for a False Positive 
File. If you try to run an existing project without setting the new options, the 
US Postal Matcher will generate an error. 

For more information, see the technical bulletin Changes to United States 
Postal Matcher (TSS Version 15.5) available from the TSS software FTP site 
and the documentation page of the Trillium Software Customer Portal website.

If you install TSS v15.5 and you use the DPV, LACSLink, 
SuiteLink, or RDI products, you must use the new product 
directories. As of August 1, 2017, Trillium Software will no 
longer make available these USPS product directories with the 
old encryption standard. Trillium Software will make available 
both new and old product directories until then, but you will 
need to update your software and product directories as soon 
as possible. 
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CHAPTER 17

TSS v15.6 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.6 release including:

 Administration Center
 Discovery Center
 Data Quality Enhancements
 Data Management Enhancements
 Enterprise Integration Enhancements

For important changes to the installation and supported platforms, see TSS 
Important Changes on page 12.

Administration Center
The Trillium Administration Center is a new, secure browser-based application 
from which TSS repository administrators add, monitor, and manage data 
repositories and data connections for Discovery Center users. Administrators 
can also configure and launch connections to web services from one location.

Features include:
 Add and edit repositories and data (loader) connections. 
 Add one or more repositories to enable Discovery Center users to sign 

in, load (or link to) their data, and run profiling activities. 
 Add one or more data connections for each type of external data source 

to which Discovery Center users plan to connect.
 Run filtered searches using one or more conditions to find repositories 

and data connections located on the current repository server. You can 
also search for particular tasks run against repository objects. 

 Configure, store, and launch connections to web services. 
 View the progress of Discovery Center queued and running tasks, such 

as business rule analysis, rule set imports, and data source creation. 
The Task Manager and Task Queue list the status of jobs that were 
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executed against all repositories on the current repository server and 
provide important information when multiple processes are running. 

 Save the row data displayed in tab views by exporting it as a comma-
separated value (.csv) file. Save the file to your local (client) system to 
share and open in other applications.

Discovery Center
The Trillium Discovery Center is a secure, browser-based application from 
which you view, manage, and analyze objects in your TSS repository including 
business rules, data sources (entities), attributes, data rows, library rule sets, 
relationship analyses, and all associated metadata.

New features include:
 Universal Keyword Search. You can use the search on the menu bar to 

find data sources, joins analyses, and rules in the Library, as well as 
data source rules.

 Using Notes. You can now view, add, edit, and delete notes associated 
with data sources and attributes. 

 Adding Rules to the Library. There is a new streamlined design, making 
it easier to promote and associate a business rule with a rule set in the 
Library.

 Exporting Tab Rows. When exporting rows in a tab view, now all tabs 
support exporting the .csv file to both server and local systems. 

 Logging Out. You can now log out of the Discovery Center when you are 
finished with your work session.

 Saving a Copy of a Data Source Rule. When you edit a data source rule, 
you can now make a copy of that rule and its properties as a new rule in 
the current data source.

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes. 

Certified Postal Matchers for 64-bit
The following certified Postal Matchers are now supported for EDQ (64-bit):

 Australia (AU) – AMAS Australia Post
 Canada (CA) – SERP Canada Post Corporation
 United States (US) – CASS United States Postal Matcher
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Customer Data Parser - Apartment Number Processing
You can now process a pound sign (#) as apartment number correctly in the 
Customer Data Parser (CDP). If the apartment number contains the # 
character and you want to keep the # character, you can do so by modifying 
the characters control file. 

By default, the CDP converts all # characters to spaces by the characters 
control file (charctl.win/unx, located in ./tables/parser_rules). As a result, 
if the address has the # character, it will be converted to a space before 
parsing begins. For example, "23 Davis Rd., #C4" becomes "23 Davis Rd.,  
C4". "C4" will still be parsed as the dwelling number, but the dwelling type is a 
'?' (no type) instead of 'A' (apartment), and the dwelling name will not include 
the # character. 

To process the # character as apartment number correctly, you can remove or 
comment out the # character from the characters control file so that the CDP 
will recognize the # character as a dwelling type of apartment.

Business Data Parser - Attribute for Mixed Case
The Business Data Parser (BDP) process now includes a new user-defined 
attribute (bp_userx_original) to contain the original data in mixed case used in 
the input. This attribute is repeated a maximum of 50 times. 

Sort Utility - SyncSort Technology
As of V15.6, Opttech Sort technology has been replaced with SyncSort 
technology. SyncSort is a high-performance sort technology offered by 
SyncSort Incorporated. SyncSort technology supports various collating 
sequences such as ASCII and EBCDIC.

Backward Compatibility with Opttech Sort
If you have existing projects using Opttech Sort, the projects now 
automatically run using SyncSort. Note the following guidelines when using 
existing projects:

 Keep just the duplicates (JUST_DUPES) - This option for the 
Duplicates setting is not currently supported by SyncSort. If your 
project includes this option, the Sort will generate an error message. 

 Retain order of same-key records (STABLE_SORT) - If the 
Preferred sort method is set to Opttech and the Retain order of same-
key records option is not selected, the Sort will internally enable this 
option to retain the order of same-key records.
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Data Management Enhancements
This section describes the enhancements incorporated into the Repository 
Manager.

Log File Management
By default, when the log reaches 1 GB, the mtb_server.log file is renamed 
with a timestamp and a new log is started. The log files can use up a lot of disk 
space and this could lead to poor performance. To avoid this problem, you can 
now control the file size before renaming occurs and specify how many 
backups to keep in your disk.

The following new parameters are available in the config.txt file, located in 
the etc folder in the Server installation directory (for example, C:/Program 
Files (x86)/Trillium Software/MBSW/15/etc). 

 logfile_size_max - The maximum size of the log file in megabytes. For 
example, logfile_size_max 500 means a maximum log file size of 
500MB. If this parameter is omitted or set to ‘0’ a default log file size of 
1024MB is applied. 

 logfile_backups - The number of backup versions of the log file. For 
example, logfile_backups 4 means keep a maximum of 4 backup 
files. If this parameter is omitted or set to ‘0’ the maximum number of 
log files is set to 255.

Example
value logfile_size_max 1024
value logfile_backups 16
When the current mtb_server.log file exceeds its configured maximum size a 
new backup file is created, and if the total number of backup files now exceeds 
the user-configured maximum, the files with the oldest timestamp are deleted 
until only the maximum number of backup files remain.

Backup files are identified as the filename pattern of mtb_
serverYYYYMMDD.log where YYYYMMDD is a datestamp in the inclusive range 
10000101 through 29991231.

For more information, see the TSS Repository Administrator’s Guide. 
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Enterprise Integration Enhancements
This section describes enhancements and updates for the following TSS 
enterprise data products.

Enterprise Data Quality (EDQ)
The EDQ installation now includes the following new client interface 
components for 64-bit processing (Windows only):

 Director System Manager (64-bit) - A graphical user interface that 
allows you to control Director, cleansing and matching. 

 Project Rule Analyzer (64-bit) - A tool that allows you to test 
cleansing and matching rules and logic.

 Web Service Manager (64-bit) - A web service test tool that allows 
you to send web service requests for cleansing and matching using TSI. 

You can launch these components by selecting Start > All Programs > 
Trillium Software > TSS 15 - EDQ (x64).

TS Web Services
The following changes are incorporated into this release: 

REST Capabilities. TS Web Services with Trillium Server Interface (TSI, 64-
bit) now supports the industry standard REST requests. (Previous version 
supported only SOAP requests.)

Trillium Software recommends that you use the following types of web 
services as best practices:

 REST for JavaScript as it is a preferred or required method.
 SOAP for back-end operation.
 REST might be faster than SOAP because of smaller pay load.

TSI Web Server Administration. TSI Web Server Administration (formerly 
the SOAP Service Administration) is an enhanced web-based application from 
which you perform various management tasks for TS Web Services with TSI, 
such as configuring and starting a project. It includes a new option for Read-
Only Users. This option allows you to create a user name and password with 
read-only access to the TSI Web Server Administration.This application is 
installed with the EDQ installation. 

Official TSI Web Service SDK. TS Web Services with TSI now includes 
Software Development Kit (SDK) to achieve cleansing and matching. This 
replaces the legacy TGenClient/Director interface. The sample files directory, 
C:\ProgramData\Trillium Software\EDQ\15\samples\SDK\TSI, includes:

 cs - C# .NET sample projects for REST and SOAP requests.
 Java- Java sample projects for REST and SOP requests.
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SSL Implementation. TS Web Services with TSI now allows you to enable 
secure data transfer through Secure Socket Layer (SSL). SSL is the standard 
security technology for establishing an encrypted link between a web server 
and a browser.

Security Error Messages. When security errors occur, the Web Service 
Manager now displays the following error messages. 

For more information, see the TS Web Services Developer’s Guide. 

Security Note for Linux
For Linux, there are separate public keys for 32-bit implementation (ECS) and 
64-bit implementation (EDQ). If you use both 32-bit and 64-bit 
implementations, you will need to add both keys to the authorized_keys 
file.

The sample public keys are located in the following directories:
 32-bit (ECS installation)

C:\Program Files(x86)\Common Files\Trillium 
Software\deployment\15\ECS_GUI\default_keys

 64-bit (EDQ installation)
C:\Program Files\Trillium Software\EDQ\15\default_keys

Alternatively, you can generate your own keys.

Example (32-bit)
command="/opt/trillium/x32/Linux/tsq/Software/bin/trilsecure.sh" 
ssh-rsa AAAAB3NzaC1...rsa-key-20080306
Example (64-bit)
command="/opt/trillium/x64/Linux/bin/trilsecure.sh" 
ssh-rsa AAAAB3NzaC1...rsa-key-20170306

Message Description

Invalid private key file The wrong private key file was used.

Permission denied (publickey) The private key file used did not match the public key.

The sample keys are for testing only. Trillium Software highly 
recommends that you generate your own keys and passphrases to 
ensure system security.
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CHAPTER 18

TSS v15.7 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.7 release including:

 Trillium Discovery and Collibra Integration
 Discovery Center
 Data Quality Enhancements
 Postal Directory Download
 Trillium Language Pack Locale Setting
 Trillium™ Discovery REST APIs and Documentation

For important changes to the installation and supported platforms, see TSS 
Important Changes on page 12.

Trillium Discovery and Collibra Integration
For TSS v15.7, a new integration is available between the Trillium Discovery 
and Collibra applications, including the Collibra Data Governance Center. The 
Data Governance Center allows you to automate data governance 
management and stewardship tasks; define communities, domains, and 
governance roles; and establish work flows. 

The integration includes a bi-directional synchronization between the 
Discovery Center and the Data Governance Center so that data quality rule 
assets built within Collibra’s Data Governance Center rulebooks are imported 
into Discovery Center as library rules in associated rule sets. 
Discovery Center users associate the rule sets with their data source rules, 
analyze their data set, and then load the results back into the Data 
Governance Center for viewing, data remediation, and to help track trends 
over time.
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Business Rule Analysis Results in Collibra
Business rule results from Discovery Center are returned and viewed in the 
Data Governance Center as follows:

 1.   In the Discovery Center, you associate a library rule set to one or more 
data sources so that an instance of each rule in the rule set is added to 
each data source. Each business rule instance retains the original 
library rule’s name and properties. 

 2.   Run analysis on the data source business rules. 

 3.   When a business rule’s status is Analyzed, rule results are copied from 
Discovery Center to the Data Governance Center at the next 
synchronization point between the products. 

 4.   In the Data Governance Center, you view business rule results 
displayed in data quality metrics. The results include the passing 
fraction value, and the number of rows in the data that passed or failed 
the analysis. Each analyzed business rule in Discovery Center has an 
associated data quality metric in Data Governance Center. 

For example, in Figure 18-1, the data quality metric Policy Type 
Validation|8|20228 Policy shows the results for the business rule Policy 
Type Validation which is associated with a data source named 20228 Policy 
with an ID value of 8.

Figure 18-1  Trillium Business Rule Analysis Results in Collibra

For information on how to configure and use the integration, see the Trillium 
Discovery and Collibra Integration Administration and User’s Guide. 
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Discovery Center
The Trillium Discovery Center is a secure, browser-based application from 
which you view, manage, and analyze objects in your TSS repository including 
business rules, data sources (entities), attributes, data rows, library rule sets, 
relationship analyses, and all associated metadata.

New features include:
 Load Dynamic Data Sources. You can now create a profiled data source 

by loading data into an existing dynamic data source. This new profiled 
data source includes all available discovered metadata and profiling 
statistics.

 Integration with Trillium Discovery and Collibra. The Discovery Center is 
used as part of the Trillium Discovery and Collibra integration. For more 
information, see Trillium Discovery and Collibra Integration on 
page 113. 

 Trillium REST API documentation is now installed with the TSS server 
software and is accessible from the Discovery Center online help 
system. In the help’s left navigation pane, click Trillium REST APIs. 
For more information, see REST API Documentation on page 118.

Data Quality Enhancements
This section describes the enhancements and changes incorporated into TS 
Quality standardization and cleansing processes. 

Trillium™ Quality for Big Data
Trillium™ Quality for Big Data integrates Trillium’s data quality application with 
Syncsort DMX-h to cleanse and match your data in the Hadoop framework. It 
validates and improves the quality of your data and identifies duplicate records 
in your database. 

Trillium Quality for Big Data uses Hadoop’s MapReduce and Spark 
infrastructure to distribute data cleansing and matching tasks across the nodes 
in the Hadoop Distributed File System (HDFS) data cluster.

Use Trillium Quality for Big Data to:
 Deploy data quality workflows as native, parallel MapReduce or Spark 

processes for optimal efficiency.
 Process hundreds of millions of records of data.
 Standardize, enhance, and match international data sets with postal- 

and country-code validation.
 Integrate, parse, standardize, and match new and legacy customer data 

from multiple disparate sources. 
 Increase processing efficiency.
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 Support failover through Hadoop’s fault-tolerant design; during a node 
failure, processing is redirected to another node.

Trillium Quality for Big Data projects are executed in Hadoop using Syncsort’s 
DMX-h, the Hadoop edition of DMExpress (provided with the solution). Trillium 
Quality for Big Data invokes the DMX-h engine at run-time and DMX-h runs 
the workflow in the project from the initial input to the final output in the 
Hadoop MapReduce or Spark framework.

Note the following:
 Trillium Quality for Big Data does not support deploying a single- or 

multi-country project containing US, CA, or AU postal certified modules 
to a Hadoop environment. Also, for US, use of Delivery Point Validation 
(DPV), Locatable Address Conversion System (LACSLink), and SuiteLink 
options is unsupported.

 Trillium Quality for Big Data is not installed automatically with the TSS 
software. The software is available as a separate Apache Ambari service 
package. To obtain the software and customized postal directories, 
contact Trillium Software. 

 Trillium Quality for Big Data replaces the previous TS Quality for Hadoop 
solution which has been deprecated and is no longer available. 

LOOKUP Function
In v15.7, the LOOKUP function, which has the syntax LOOKUP(attribute, 
entity_name/entity_ID, attribute_id), has been modified so that when you use 
entity name (which contains the attribute to be looked up) rather than entity 
ID, and there are multiple entities with the same name, the function returns 
results for the entity with the highest (most recent) ID value. 

For example, if there are three entities with ID values of 1, 2, and 8, entity 8 
will be returned.

Unique ID (UUID) Function
There is a new Quality function in the Expression Builder called UNIQUE_ID 
used to generate universally unique identifiers (UUIDs). A UUID is a unique 
36-character permanent key used for record identification for large data 
volume. 

Postal Directory Download
Postal directories are a critical part of the TSS data quality process because 
they provide the address information used to validate and improve the name 
and address data in your records. 

Starting in TSS v15.7, there are now two ways that Trillium Software 
distributes the updates: 
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 Trillium Postal Download Web Service (New). Trillium Postal Download 
Web Service is an automated download service introduced in v15.7. The 
download service allows you to check the status of your postal license 
and download the postal directories from a browser-based application.

 TSS Download Center (File Portal) FTP website. TSS Download Center 
allows you to manually download postal directories through Trillium 
Software’s secure website. See the Trillium Software System 
Installation Guide for procedures on downloading postal directories 
through this website.

For more information, see the Trillium Postal Download Web Service User’s 
Guide. 

Trillium Language Pack Locale Setting
Now there is a new REST API value locale setting in the TSS server 
config.txt file used to specify the locale for applications that use the Trillium 
REST API (including Discovery Center and Administration Center). This will 
allow the applications to display text in the proper language.

After you install a language pack, open the config.txt file and update the 
value locale parameter. For example, the following specifies the locale as 
German:

key rest_api {
    value locale "de"
}

For more information, see the TSS Repository Manager’s Guide or the 
Administration Center online help. 

Trillium™ Discovery REST APIs and 
Documentation

The Trillium™  Discovery REST API provides methods of accessing and 
manipulating repositories, entities (data sources), and business rules. The 
methods also support working with the Business Rule Library and data 
relationships like joins, keys, and dependencies.

How the APIs are Used
The Trillium Discovery Center and the Trillium Discovery and Collibra 
Integration use the TSS REST APIs queries and commands to run all profiling 
tasks. The Administration Center uses the APIs to create loader connections, 
repositories, and to configure and launch links that connect to a web service. 

The APIs are available for advanced users to customize the Trillium Discovery 
and Collibra integration or create applications that use the profiling services.
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REST API Documentation
The Trillium Discovery Rest APIs are installed with the TSS server software. 
Accompanying API online help is available to be used as a reference for the 
standard requests, including parameters, examples, response codes, external 
JSON format, and so on. 

The API online help is accessible from the Discovery Center online help 
system. In Discovery Center, click Help > Open Online Help. In the help’s 
left navigation pane, click Trillium REST APIs.

You can also access the REST API documentation directly from server 
installation location:

 Windows: C:\Program Files (x86)\Trillium Software\MBSW\15\
          svr\client\docs\RestAPI\html

 Linux: install_path/server/metabase/svr/client/docs/
       RestAPI/html

To open the system in a browser, double-click the index.htm file in the html 
directory. 
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CHAPTER 19

TSS v15.7.4 Enhancements

This chapter describes the enhancements and updates included in the TSS 
v15.7.4 release, including:

 Apache Tomcat Upgrade on page 119
 Australian (AU) Postal Directories and AU Postal Matcher Changes on 

page 119

Apache Tomcat Upgrade
As of v15.7.4, the version of Apache Tomcat installed with the TSS server has 
been upgraded to v8.5.32.

Australian (AU) Postal Directories and AU 
Postal Matcher Changes

v15.7.4 includes the following changes to the Australian (AU) postal directories 
and AU Postal Matcher. Effective on November 1, 2018, in accordance with 
Australia Post licensing terms, the following changes will be made:

 Automatic Expiry. The AU postal directories will automatically expire 
according to the schedule (AU Postal Directories Expiry Dates on 
page 120). If the postal directories are not updated before the last day 
of the expiration month, the AU Postal Matcher will be shut down. See 
AU Postal Directories Expiry Dates on page 120 for the delivery 
schedule and shutdown dates. 

 New Directories. From August 2018, Syncsort will deliver the new AU 
postal directories that are compliant with these changes. 

 Address Matching Approval System (AMAS). As of v15.7.4, AMAS 
certification is only available on 64-bit Windows and Linux. Any other 
version and platform will no longer support AMAS certification.

 Delivery Point Identifier (DPID). The Delivery Point Identifier 
(DPID) can only be returned if the AU Postal Matcher is run in AMAS 
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mode. If you wish to continue receiving the DPID information and you 
are not currently running in AMAS mode, you will need to modify a 
project within the AU Postal Matcher process to enable AMAS 
certification.

 Incremental Changes File (ICF). The Incremental Changes File 
(ICF), containing change information about the DPID field from a 
previous version of the PAF file, will no longer be available.

For more information, see the technical bulletin Changes to Australian (AU) 
Postal Directories and AU Postal Matcher available from the TSS software FTP 
site and the documentation page of the Syncsort Customer Portal website.

AU Postal Directories Expiry Dates
Table 19-1 shows the AU postal directories’ delivery schedule for 2018/2019 
and the last valid date for each delivery. When the directories are used past 
the last valid date, the AU Postal Matcher program will be automatically shut 
down. 
v15.7 or higher includes Postal Download Web Service to allow you to check 
the status of your postal license and download the postal directories from a 
browser-based application. Syncsort recommends that you update the 
directories every month using the Postal Download Web Service. 

The AU postal directories are delivered every month, except for 
January. The delivery schedule is the same for every year. 

Table 19-1 AU Postal Matcher Shutdown Dates

Directory Delivery Date Valid Until Last Day of Month

August 2018 December 2018

September 2018 January 2019

October 2018 March 2019

November 2018 April 2019

December 2018 May 2019

February 2019 June 2019

March 2019 July 2019

April 2019 August 2019

May 2019 September 2019

June 2019 October 2019

July 2019 November 2019

August 2019 December 2019

September 2019 January 2020
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October 2019 March 2020

November 2019 April 2020

December 2019 May 2020

Table 19-1 AU Postal Matcher Shutdown Dates

Directory Delivery Date Valid Until Last Day of Month
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CHAPTER 20

TSS Documentation

This chapter describes enhancements and changes to the TSS documentation 
set. The TSS documentation set has been updated to reflect all the changes 
described in this document. 

TSS Documentation Set
In addition to this document, see the following documents installed with 
software:

 TSS Help
 TSS Installation Guide
 TSS Repository Administrator’s Guide
 Administration Center Help
 Discovery Center Help
 Trillium REST API Documentation

If you find errors in this or any Trillium Software documentation, 
have suggestions for additional topics, or have any other comments, 
please contact the Documentation team through Trillium’s Customer 
Support department. 
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Changes and Updates
The TSS documentation set, including the Help system and PDF manuals have 
been updated as follows:

 As of v15.0.0 the TSS Getting Started Guide is no longer published. All 
information you need to get started with the Control Center interface is 
available in the TSS Help, mainly in the Getting Started and Tour 
sections. 

 The TSS Help has been enhanced to include the following:
•   Basic Steps. There is a new tab in the TSS Help called Basic Steps. 

Basic Steps contains grouped topics to help guide you through 
various widely-used TSS processes and tasks including creating an 
entity, profiling your data with business rules, validating address 
data, and parsing data.

•   Use Cases. There is a new top-level TOC folder called Use Cases. 
Use Cases highlight example scenarios and best practices for how to 
utilize certain TSS processes and procedures such as identifying 
duplicates in your data using the Relationship Linker and practical 
ways to profile your data.

•   New Search Functionality. Search results include more context 
and details on returned topics. 

•   New Look. Updated look and feel. 
 The TSS Help system supports Internet Explorer versions 10 and 11.

If you use a browser other than Internet Explorer to view the 
online help, certain formatting elements will not display 
correctly.

 The Trillium Administration Center and the Discovery Center include a 
full set of online documentation. Every page of the Administration 
Center and Discovery Center, and most panels and windows include a 
question mark icon ( ). Click the icon for more information about the 
task or tasks that you can perform in the current page, panel, or 
window. 

 Director SDK Documentation. The information in the Director SDK 
Reference Guide has been modified as follows: the XML-over-HTTP, NET 
Web Services, and J2EE chapters have been removed and are now 
available in three separate documents:
•   TS Director XML-Over-HTTP Developer’s Guide
•   TS Director IIS .Net Web Services Developer’s Guide
•   TS Director J2EE Interface Developer’s Guide (Discontinued as of 

TSS v15.4. See TS Director (32-Bit) Web Services on page 104.)
 As of TSS v15.7, the TS Quality for Hadoop product has been replaced 

with Trillium Quality for Big Data. Therefore, the TS Quality for Hadoop 
Developer’s Guide has been discontinued. For information about using 
Trillium Quality in a Hadoop environment, see the Trillium Quality for 
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Big Data Developer’s Guide and the Trillium Quality for Big Data 
Installation Guide, new for v15.7. 

 Trillium REST API documentation is now installed with the TSS server 
software (Windows and Linux) and is accessible from the Discovery 
Center online help system. In Discovery Center, click Help > Open 
Online Help. In the help’s left navigation pane, click Trillium REST 
APIs.

You can also access the REST API documentation directly from server 
installation location:

•   Windows: C:\Program Files (x86)\Trillium Software\MBSW\15\
          svr\client\docs\RestAPI\html

•   Linux: install_path/server/metabase/svr/client/docs/
       RestAPI/html

To open the system in a browser, double-click the index.htm file in the 
html directory. 

Accessing Documentation
The TSS documentation is available as follows:

 Online. The latest technical documentation for each TSS release is 
posted and maintained on the Documentation page of the Trillium 
Software Customer Portal website. Manuals and technical bulletins are 
available as PDFs and can be downloaded from the Customer Portal. 
The Customer Portal is constantly updated. Check the website 
occasionally to ensure you have the latest edition of a manual or 
technical bulletin. All customers with an active Trillium Software 
maintenance plan have access the Customer Portal.

 From the Control Center and Repository Manager. The TSS Help, 
TSS Repository Administrator’s Guide, TSS Beyond the Basics, and the 
TS Reporting Adapter for Excel User’s Guide are accessible in the 
Control Center and Repository Manager by opening the Trillium 
Software System Documentation page:
•   Click the Help options icon ( ) and select Manuals.
•   (Control Center only) From the Getting Start page under Helpful 

Links, click View Documentation.
 From the Administration Center. To access the main Administration 

Center Online Help system:
•   Click Help > Online Help. The Help menu is always available 

regardless of which panel or page you are on. 
•   Press the F1 key to launch the Online Help at any time. 

 From the Discovery Center. To access the main Discovery Center 
Online Help system:
•   Click Help > Online Help. The Help menu is always available 

regardless of which panel or page you are on. 
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•   Press the F1 key to launch the Online Help at any time. 
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CHAPTER 21

Troubleshooting

This chapter describes important troubleshooting workarounds. It includes the 
following sections:

  Setting the LD_LIBRARY_PATH Variable When Exporting Quality 
Profiling Projects to Batch (UNIX) on page 126

  Connecting DB2 Adapter to iSeries on page 127
  Discovery Center Does Not Open on page 128
  Apache Tomcat server.xml Is Missing When EDQ Is Upgraded to 

v15.7.4 from v15.7.0 (Linux) on page 128 

Setting the LD_LIBRARY_PATH Variable 
When Exporting Quality Profiling Projects to 
Batch (UNIX)

Before you run a batch script for an exported project that contains Quality 
profiling processes, you must set the LD_LIBRARY_PATH environment variable 
to point to your system's libcore library directory. 
This procedure applies to exported Quality projects that contain one or more of 
the following profiling processes:

 Business Rules
 Dependencies
 Keys
 Load

For more information about exporting projects that contain profiling 
processes, see the TSS Help: Develop > TS Quality Processes > 
Profiling Processes. 

Note the following:
 You must be a TSS repository or systems administrator to complete this

procedure.
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 Set the environment variable at any time before you export the project 
and run it in batch.

 This procedure permanently sets the LD_LIBRARY_PATH environment 
variable in your environment so that you do not have to set it each time 
you start a session. 

 To set the LD_LIBRARY_PATH on UNIX

 1.   Open the .cshrc settings file, located in your home directory.

Figure 21-1  .cshrc File Example

 2.   Add the LD_LIBRARY_PATH environment variable to the variable list. 

 3.   Set it to point to Software/bin directory of your TSS installation. This is 
used as the libcore library directory. 

For example, setenv LD_LIBRARY_PATH /.../Linux/15/tsq/
Software/bin

 4.   Save the file. 

 5.   Source the file by running the following command: 

source .cshrc

Connecting DB2 Adapter to iSeries
When adding DB2 data connections to iSeries DB2 platform (AS/400), for the 
connection to your repository to be properly configured, you must modify the 
TSS config.txt file by adding the entry value iseries 1 to the end of the key 
rdbms section. For example:

key rdbms {
    value uncommitted_read "off"
    value records_read 100
    value records_read_odbc 1
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    value iseries 1 
}

Make this change either before or after you add the loader connection in the 
Repository Manager, but use the connection only after the change. 

The config.txt file is located in the server install directory on your TSS server 
system. On Windows 7 this directory is C:/Program Files/Trillium 
Software/MBSW/15/etc.

Discovery Center Does Not Open
Problem

Logging in to the Discovery Center fails with a message telling you the page 
cannot be displayed. 

Solution

On the TSS server system, start the TSS 15 Rest APIs service and try logging 
in again.

Apache Tomcat server.xml Is Missing When EDQ Is 
Upgraded to v15.7.4 from v15.7.0 (Linux)

Problem

When you upgrade TSS v15.7.0 EDQ to v15.7.4 EDQ on Linux, the Apache 
Tomcat server.xml file will not be installed in the /apache-tomcat-8.5.32/
conf directory.

Solution

Instead of upgrading v15.7.0, uninstall v15.7.0 first and then install v15.7.4.
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